Fiery Graphic Arts Package
## CONTENTS

### INTRODUCTION
- Terminology and conventions
- About this manual
- Fiery Graphic Arts Package
- Fiery Graphic Arts Package, Premium Edition
- Available upgrades for feature packages
- Enabling the features at the Fiery EXP6000/EXP5000
- Updating the status of Fiery Graphic Arts Package
  - Updating the status on Windows
  - Updating the status on Apple Mac OS
- Setting up your monitor and the monitor profile

### PAPER SIMULATION WHITE POINT EDITING
- Paper simulation workflow
- Printing a job with default Paper Simulation
  - Paper Simulation print option
- Paper Simulation White Point editing
  - Paper Simulation White Point dialog box
  - Editing Paper Simulation White Point
- Printing a job with the custom paper simulation values
### Spot-On with Substitute Colors

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Substitute Colors workflow</td>
<td>25</td>
</tr>
<tr>
<td>Creating a color for substitution</td>
<td>25</td>
</tr>
<tr>
<td>Defining the color values for a substitute color</td>
<td>27</td>
</tr>
<tr>
<td>Printing a job with a substitute color</td>
<td>30</td>
</tr>
<tr>
<td>Substitute Color dialog box</td>
<td>31</td>
</tr>
<tr>
<td>Principles for Substitute Colors</td>
<td>33</td>
</tr>
<tr>
<td>Tolerance range</td>
<td>33</td>
</tr>
<tr>
<td>Color substitution</td>
<td>34</td>
</tr>
<tr>
<td>Priority scheme</td>
<td>34</td>
</tr>
<tr>
<td>Uploading and downloading a substitute color group</td>
<td>35</td>
</tr>
</tbody>
</table>

### Color Setup

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ColorWise Pro Tools Color Setup</td>
<td>36</td>
</tr>
<tr>
<td>Using Color Setup</td>
<td>36</td>
</tr>
<tr>
<td>Control Bar</td>
<td>38</td>
</tr>
<tr>
<td>Control Bar workflow</td>
<td>38</td>
</tr>
<tr>
<td>Printing with default Control Bar</td>
<td>38</td>
</tr>
<tr>
<td>Control Bar pane</td>
<td>40</td>
</tr>
<tr>
<td>Printing with a custom Control Bar</td>
<td>45</td>
</tr>
<tr>
<td>Configurable Auto Trapping</td>
<td>46</td>
</tr>
<tr>
<td>Configurable Auto Trapping workflow</td>
<td>46</td>
</tr>
<tr>
<td>Printing with default Auto Trapping</td>
<td>46</td>
</tr>
<tr>
<td>Auto Trapping pane</td>
<td>47</td>
</tr>
<tr>
<td>Setting the Apply Auto Trapping option to On</td>
<td>47</td>
</tr>
<tr>
<td>Defining custom values for Auto Trapping</td>
<td>49</td>
</tr>
<tr>
<td>Printing a job with the configurable Auto Trapping feature</td>
<td>49</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------</td>
</tr>
<tr>
<td><strong>About Progressives</strong></td>
<td>50</td>
</tr>
<tr>
<td>Progressives workflow</td>
<td>50</td>
</tr>
<tr>
<td>Printing a job with default Progressives</td>
<td>51</td>
</tr>
<tr>
<td>Progressives pane</td>
<td>52</td>
</tr>
<tr>
<td>Specifying color channels</td>
<td>53</td>
</tr>
<tr>
<td>Printing a job with custom Progressives</td>
<td>53</td>
</tr>
<tr>
<td><strong>SOFT PROOFING</strong></td>
<td>54</td>
</tr>
<tr>
<td>Viewing soft proofs</td>
<td>54</td>
</tr>
<tr>
<td><strong>EFI IMAGEVIEWER</strong></td>
<td>57</td>
</tr>
<tr>
<td>Accessing ImageViewer</td>
<td>57</td>
</tr>
<tr>
<td>ImageViewer main window</td>
<td>59</td>
</tr>
<tr>
<td>Menu commands</td>
<td>60</td>
</tr>
<tr>
<td>Toolbar</td>
<td>61</td>
</tr>
<tr>
<td>Navigator pane</td>
<td>62</td>
</tr>
<tr>
<td>Color Adjust pane</td>
<td>63</td>
</tr>
<tr>
<td>Separations pane</td>
<td>65</td>
</tr>
<tr>
<td>Image Preview pane</td>
<td>66</td>
</tr>
</tbody>
</table>
# EFI Hot Folders Filters

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About file conversion</td>
<td>67</td>
</tr>
<tr>
<td>Filters</td>
<td>68</td>
</tr>
</tbody>
</table>

## Specifying filter settings for a Hot Folder

- About PS->PDF Normalizer                            | 70   |

## Configuring the filters

- Configuring the TIFF/IT to PS filter                | 72   |
- Configuring the CT/LW to PS filter                  | 73   |
- Configuring the DCS 2.0 to PS filter                | 74   |
- Configuring ExportPS filter                         | 75   |
- Configuring the PDF2Go filter                       | 75   |
- Configuring the EPS to PS filter                    | 76   |
- Configuring the PDF/X Preflight filter              | 77   |
- Configuring the TIFF to PDF filter                  | 77   |
- Configuring the JPEG to PDF filter                  | 79   |

# Halftone Screening

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Halftone screening workflow</td>
<td>80</td>
</tr>
<tr>
<td>Halftone Screen print option</td>
<td>80</td>
</tr>
<tr>
<td>Printing a job with a pre-set halftone screen</td>
<td>81</td>
</tr>
<tr>
<td>Halftone Screen Definitions pane</td>
<td>81</td>
</tr>
<tr>
<td>Setting Halftone Screen Definitions</td>
<td>82</td>
</tr>
<tr>
<td>Calibrating for custom halftone screens</td>
<td>84</td>
</tr>
<tr>
<td>Profiling for custom halftone screens</td>
<td>85</td>
</tr>
<tr>
<td>Printing with a custom halftone screen</td>
<td>86</td>
</tr>
</tbody>
</table>

## Supported applications

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
</table>

---
INTRODUCTION

Because of the flexibility of the controls Fiery Graphic Arts Package (FGAP) provides, users in any environment can benefit from the Fiery Graphic Arts Package features. Novice users can use the default settings to obtain optimal results. Expert users with specific needs and requirements in graphic arts and other markets can also obtain optimal results by customizing the settings. This manual explains the Fiery Graphic Arts Package features and how they work.

Terminology and conventions

The documentation for the Fiery EXP6000/EXP5000 Color Server uses the following terminology and conventions.

<table>
<thead>
<tr>
<th>Term or convention</th>
<th>Refers to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aero</td>
<td>Fiery EXP6000/EXP5000 (in illustrations and examples)</td>
</tr>
<tr>
<td>Digital press</td>
<td>DocuColor 6060/5252/2060/2045</td>
</tr>
<tr>
<td>Fiery EXP6000/EXP5000</td>
<td>Fiery EXP6000/EXP5000 Color Server</td>
</tr>
<tr>
<td>Titles in <em>italics</em></td>
<td>Other books in this documentation set</td>
</tr>
<tr>
<td><img src="std.png" alt="Standard" /></td>
<td>Fiery Graphic Arts Package (Standard for Fiery EXP6000, optional for Fiery EXP5000)</td>
</tr>
<tr>
<td><img src="pre.png" alt="Premium" /></td>
<td>Fiery Graphic Arts Package, Premium Edition (Optional for Fiery EXP6000/EXP5000)</td>
</tr>
<tr>
<td><img src="help.png" alt="Help" /></td>
<td>Topics for which additional information is available by starting Help in the software</td>
</tr>
<tr>
<td><img src="tip.png" alt="Tip" /></td>
<td>Tips and information</td>
</tr>
<tr>
<td><img src="imp.png" alt="Important" /></td>
<td>Important information</td>
</tr>
<tr>
<td><img src="warn.png" alt="Warning" /></td>
<td>Important information about issues that can result in physical harm to you or others</td>
</tr>
</tbody>
</table>
About this manual

This manual covers the features available with EFI Fiery ColorWise Pro Tools, EFI Command WorkStation, other utilities, and at other locations. The features are organized as follows:

- Features accessible from or used to set the values in ColorWise Pro Tools
  - Paper Simulation White Point Editing describes the white point editing feature with Color Editor.
  - EFI Spot-On with Substitute Colors describes the features to manage color substitution.
  - Color Setup describes the Control Bar, Auto Trapping, Progressives features.

- Features accessible from Command WorkStation
  - Soft Proofing describes the Soft Proof feature.
  - EFI ImageViewer describes the features available with ImageViewer.

- Features accessible from or used to set the values in the utilities other than ColorWise Pro Tools and Command WorkStation
  - EFI Converter describes the TIFF/IT converting feature.
  - EFI Hot Folders filter plug-ins describes the filter plug-ins features.
  - Halftone Screening describes the halftone screen feature available with Fiery Server Setup.

- Other features
  - Postflight describes the Postflight feature and its workflow examples.
  - Multiple Plate Separations describes the combine separation feature for more than four plates.
  - HKS, DIC, and Toyo Ink Support describes the additional ink support feature.
  - Paper Simulation describes the fixed Paper Simulation feature.
**Fiery Graphic Arts Package**

The following features are included in Fiery Graphic Arts Package:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Where to set values or access</th>
<th>Print option name</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft proofing</td>
<td>Command WorkStation</td>
<td></td>
<td>Soft Proofing</td>
</tr>
<tr>
<td>Halftone screening</td>
<td>Fiery Server Setup or Control Panel</td>
<td>Halftone Screen</td>
<td>Halftone Screening</td>
</tr>
<tr>
<td>Multiple plate separations</td>
<td></td>
<td></td>
<td>Multiple Plate Separations</td>
</tr>
<tr>
<td>HKS, DIC, and Toyo ink support</td>
<td>ColorWise Pro Tools Spot-On</td>
<td>Spot Color Matching</td>
<td>HKS, DIC, and Toyo Ink Support</td>
</tr>
<tr>
<td>Fixed paper simulation</td>
<td></td>
<td>Paper Simulation</td>
<td>Paper Simulation</td>
</tr>
</tbody>
</table>

**Fiery Graphic Arts Package, Premium Edition**

The following features are included in Fiery Graphic Arts Package, Premium Edition:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Where to set values or access</th>
<th>Print option name</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper simulation white point editing</td>
<td>ColorWise Pro Tools Color Editor</td>
<td>Paper Simulation</td>
<td>Paper Simulation White Point Editing</td>
</tr>
<tr>
<td>Spot-On: color substitution</td>
<td>ColorWise Pro Tools Spot-On</td>
<td>Substitute Colors</td>
<td>Spot-On with Substitute Colors</td>
</tr>
<tr>
<td>Control Bar</td>
<td>Fiery Server Setup or Control Panel</td>
<td>Control Bar</td>
<td>Color Setup</td>
</tr>
<tr>
<td>Configurable auto trapping</td>
<td>ColorWise Pro Tools Color Setup</td>
<td>Auto Trapping</td>
<td>Color Setup</td>
</tr>
<tr>
<td>Progressives</td>
<td>ColorWise Pro Tools Color Setup</td>
<td>Progressives</td>
<td>Color Setup</td>
</tr>
<tr>
<td>ImageViewer</td>
<td>Command WorkStation: ImageViewer</td>
<td></td>
<td>EFI ImageViewer</td>
</tr>
<tr>
<td>Hot Folders file filters</td>
<td>Hot Folders</td>
<td></td>
<td>EFI Hot Folders Filters</td>
</tr>
<tr>
<td>Halftone screening with frequency control per color</td>
<td>Fiery Server Setup or Control Panel</td>
<td>Halftone Screen</td>
<td>Halftone Screening</td>
</tr>
<tr>
<td>Postflight</td>
<td>Command WorkStation: ImageViewer</td>
<td>Postflight</td>
<td>Postflight</td>
</tr>
<tr>
<td>Multiple plate separations</td>
<td></td>
<td></td>
<td>Multiple Plate Separations</td>
</tr>
<tr>
<td>HKS, DIC, and Toyo ink support</td>
<td>ColorWise Pro Tools Spot-On</td>
<td>Spot Color Matching</td>
<td>HKS, DIC, and Toyo Ink Support</td>
</tr>
<tr>
<td>Fixed paper simulation</td>
<td></td>
<td>Paper Simulation</td>
<td>Paper Simulation</td>
</tr>
</tbody>
</table>
Available upgrades for feature packages

Different feature packages are available for Fiery EXP6000 and Fiery EXP5000. For details, see the following table.

<table>
<thead>
<tr>
<th>Fiery Graphic Arts Package</th>
<th>Fiery Graphic Arts Package, Premium Edition</th>
<th>To use Fiery Graphic Arts Package, Premium Edition features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiery EXP6000</td>
<td>Standard</td>
<td>Upgrade Fiery Graphic Arts Package to Fiery Graphic Arts Package, Premium Edition.</td>
</tr>
<tr>
<td>Fiery EXP5000</td>
<td>Optional</td>
<td>Upgrade to Fiery Graphic Arts Package and Upgrade Fiery Graphic Arts Package to Fiery Graphic Arts Package, Premium Edition</td>
</tr>
</tbody>
</table>

Enabling the features at the Fiery EXP6000/EXP5000

To access the Fiery Graphic Arts Package or Fiery Graphic Arts Package, Premium Edition features from your computer, one of the options must first be enabled at the Fiery EXP6000/EXP5000. A service technician enables an option at your site using the Feature Update or Restore/Update Server Software CD and the hardware key (dongle).

Updating the status of Fiery Graphic Arts Package

Before you use the Fiery Graphic Arts Package, Premium Edition features with the Fiery EXP6000/EXP5000, you must first upgrade the Fiery EXP6000/EXP5000 with the Fiery Graphic Arts Package, Premium Edition and then update the status on your computer.

Even if both packages are available at your site, only one package is enabled at a time at the Fiery EXP6000/EXP5000. If Fiery Graphic Arts Package, Premium Edition is enabled, there is no need to enable Fiery Graphic Arts Package.

Updating the status on Windows

Use the following procedure to update the status of Fiery Graphic Arts Package on a Windows computer.

**NOTE:** Before updating the status on a Windows computer, you must install the printer driver. For information about installing the printer driver to a Windows computer, see *Printing from Windows*.
NOTE: This procedure is for Windows 2000/XP/Server 2003 only. The printer drivers for Windows 98/Me and Windows NT 4.0 do not support Fiery Graphic Arts Package, Premium Edition. When printing from one of these operating systems, print your job to the Hold queue and override the job settings in Command WorkStation.

To Update the Status on a Windows Computer

1. Click Start, choose Settings, and then choose Printers.
2. Right-click the Fiery EXP6000/EXP5000 and choose Properties.
   The Properties dialog box appears.
3. Click the Installable Options tab.

4. Select the Two-Way Communication option.
   NOTE: To use the Fiery Graphic Arts Package or Fiery Graphic Arts Package, Premium Edition features, update the status of the Fiery EXP6000/EXP5000 by selecting the Two-Way Communication option.
5. Type the IP address or DNS name of the Fiery EXP6000/EXP5000.
6. Click Update.
   The Fiery Graphic Arts Package that is enabled at the Fiery EXP6000/EXP5000 appears in the Installed Options list.
Updating the status on Apple Mac OS

Use the following procedure to update the status of Fiery Graphic Arts Package on a computer running Max OS X.

**NOTE:** Before updating the status of Fiery Graphic Arts Package on a computer running Mac OS X, install the printer driver. For information about installing the printer driver, see *Printing from Mac OS*.

**NOTE:** This procedure is for Mac OS X only. The printer drivers for Mac OS 9 do not support Fiery Graphic Arts Package, Premium Edition. When printing from Mac OS 9, print your job to the Hold queue and override the job settings in Command WorkStation.

**TO UPDATE THE STATUS ON A COMPUTER RUNNING MAC OS X**

2. Select your printer in the Printer List.
3. Choose Show Info from the Printer menu.
4. Choose Installable Options in the Printer Info dialog box.
5. Choose the Fiery Graphic Arts Package from the GA Package menu.
   **NOTE:** If Two-Way Communication is selected, the Fiery Graphic Arts Package that is enabled at the Fiery EXP6000/EXP5000 appears in the GA Package menu.
6. Click Apply Changes.
7. Close the dialog box.
Setting up your monitor and the monitor profile

Some Fiery Graphic Arts Package features require that a job be displayed with correct colors on your monitor.

The following features require the correct monitor display:

- Paper Simulation White Point editing (see page 16)
- Spot-On Substitute Colors (see page 25)
- Soft Proofing from Command WorkStation
- ImageViewer previewing from Command WorkStation (see page 57)

To display the colors correctly on your monitor, you must set up the monitor display according to the manufacturer’s recommendations, and specify the correct monitor profile for your monitor.

Specify the following settings for the monitor display:

- At the monitor: Brightness, Contrast, and Temperature
- From the control panel of the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up your monitor and the monitor profile, see the documentation that accompanies the monitor.

**NOTE:** Some of the monitor profiles, including those for the Fiery Advanced Controller Interface (FACI) monitors, are installed when you install Command WorkStation.
Paper Simulation White Point Editing

Although an ICC profile contains a definition of “white,” the white may not always visually match the human eye, requiring a perceptual adjustment. The Paper Simulation White Point editing feature allows you to perceptually adjust the hue, brightness, and saturation of the simulated paper white defined in the ICC profile.

Paper simulation workflow

You can print a job with the Paper Simulation feature set to On from the printer driver without customizing paper simulation. Many jobs may print satisfactorily with the fixed default Paper Simulation setting. However, you can customize the paper simulation by editing the white point values with ColorWise Pro Tools Color Editor. After you customize the values, print the job with the custom paper simulation values from the printer driver by setting the Paper Simulation print option to On.

To print a job with the fixed Paper Simulation setting, use the procedure on page 17. For more information about editing Paper Simulation White Point values and printing with custom paper simulation values, see page 18.
Printing a job with default Paper Simulation

Use the following procedure to print a job with the fixed Paper Simulation value.

**NOTE:** The procedures for printing a job from a Mac OS or a Windows computer are similar.

---

**TO PRINT A JOB WITH DEFAULT PAPER SIMULATION**

1. Choose Print from your application.
2. Select Fiery EXP6000/EXP5000 as your printer, and click Properties.
   The Properties dialog box appears with the Fiery Printing tab selected.
3. Click the ColorWise print option bar.
4. Click Expert Settings.
   The Expert Color Settings dialog box appears.
5. Select Paper Simulation.
6. Click OK to close the Expert Color Settings dialog box.
7. Click OK to close the Properties dialog box.
8. Click Print.
   The job prints with the default Paper Simulation White Point setting.

---

**Paper Simulation print option**

The following values are available for the Paper Simulation print option:

- Off (Default)
- On

**NOTE:** If you have not edited the Paper Simulation White Point values with Color Editor and select On for this option, a job is printed with the default Paper Simulation values. If you have edited them, a job is printed with the custom Paper Simulation values.
Paper Simulation White Point editing

Your job may print satisfactorily with the fixed Paper Simulation setting. However, you can customize the Paper Simulation setting by editing the Paper Simulation White Point values with ColorWise Pro Tools Color Editor.

Paper Simulation White Point dialog box

The Paper Simulation White Point dialog box displays Hue, Brightness, and Saturation sliders. A graphic under each slider displays the current setting. To adjust the settings, drag the slider left or right, or type a value in the editable text field to the right of the slider bar.

NOTE: The sliders do not show absolute values. The slider position and associated values are relative to the paper white definition in effect when you open the dialog box.

Hue

This setting allows you to change the hue of the Paper Simulation White Point. Specify a value between 0.0 and +359.9. If you specify a value greater than 359.9, it automatically changes to 359.9. If you specify a value less than 0.0, it automatically changes to 0.0.

Brightness

This setting allows you to change the brightness of the Paper Simulation White Point. Specify a value between 0.0 and 100.0 (inclusive). If you specify a value greater than 100.0, it automatically changes to 100.0. If you specify a value less than 0.0, it automatically changes to 0.0.

Saturation

This setting allows you to change the saturation of the Paper Simulation White Point. Specify a value between 0.0 and 100.0 (inclusive). If you specify a value greater than 100.0, it automatically changes to 100.0. If you specify a value less than 0.0, it automatically changes to 0.0.
Preview

This area in the lower-left corner of the dialog box displays a preview of the paper simulation color, surrounded by a white border for contrast. The preview is based on the monitor profile you specified next to Current Monitor Profile.

To preview the color correctly with your monitor, make sure that the Monitor Compensation option is selected and that the correct monitor profile is selected for your monitor. For more information about selecting the monitor profile, see page 21.

**NOTE:** To display the colors correctly with your monitor, you must also set the monitor and monitor settings correctly. For more information, see page 15.

Editing Paper Simulation White Point

To edit a custom profile, do the following:

- Select a CMYK Simulation Profile.
- Select Full (Output GCR) for a simulation method.
- Link the simulation profile to an output profile.

Use the following procedure to access the Paper Simulation White Point dialog box to edit the values.

**NOTE:** If Paper Simulation is set to On, and you have defined a substitute color as C=0, M=0, Y=0, K=0, the values defined in Substitute Colors override those for Paper Simulation. For information about Substitute Colors, see “Spot-On with Substitute Colors” on page 25.

---

To access the Paper Simulation White Point dialog box

1. Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.

Start ColorWise Pro Tools from a stand-alone application or Command WorkStation, at your computer or at the monitor connected to the Fiery EXP6000/EXP5000.
2 Click Color Editor.

3 Choose Simulation from the View menu.

![Select Profile Dialog]

NOTE: You can edit the white point values of simulation profiles only. You cannot edit those of output profiles.

4 Select a simulation profile and click Select.

The Color Editor dialog box appears.

5 Select Full (Output GCR) in the Edit Mode menu.

6 Select an output profile to link to the edited simulation profile.

NOTE: When you print a job with the edited simulation profile later, you must select the same output profile you linked to here to realize the effect of the Paper Simulation White Point editing.
7 Click Paper Simulation.

The Paper Simulation White Point dialog box appears.

Use the following procedure to edit the Paper Simulation White Point values.

**To edit Paper Simulation White Point values**

1 Select the Monitor Compensation option in the Paper Simulation White Point dialog box.

2 Make sure that the correct monitor profile for your monitor is displayed next to Current Monitor Profile.

3 If the correct monitor profile is not selected, click Monitor.

   The Select Monitor Profile dialog box appears.

4 Choose ICC Profiles from the Format menu.

5 Select the monitor profile for your monitor and click Open.

   The Paper Simulation White Point dialog box appears.

6 Edit the Hue, Brightness, and Saturation values.

   Edit the values by dragging the sliders or typing the values in the text fields. For detailed information about the Paper Simulation White Point dialog box, see page 18.
7 View the changes in the preview patch in the lower-left corner of the dialog box.

8 Click Print.

The Print Test dialog box appears.

9 Choose settings from the Paper Size and Input Tray menus and click Print.

10 Click OK to close the Paper Simulation White Point dialog box.

11 Click Save in the Color Editor dialog box.

The Save dialog box appears.

12 Type a new name and click Save.

13 Quit Color Editor.
Printing a job with the custom paper simulation values

After you edit the paper simulation values in Color Editor, you can print a document with the custom paper simulation values from the printer driver. You can also override the setting with Command WorkStation with a similar procedure.

**NOTE:** The procedures for printing a job from a Windows or Mac OS computer are fundamentally the same. The following procedure uses illustrations from a Mac OS computer.

Use the following procedure to print a job with the custom paper simulation values.

**TO PRINT A JOB WITH EDITED PAPER SIMULATION VALUES**

1. **Choose Print in your application.**
   
The print dialog box appears.

2. **Mac OS X v10.3:** Choose ColorSync from the Copies & Pages menu.
   
The ColorSync pane appears.

3. **Choose In Printer from the Color Conversion menu.**

4. **Choose ColorWise from the Copies and Pages menu.**
   
The ColorWise pane appears.

5. **Select Two-Way Communication.**
   
For information about enabling Two-Way Communication, see *Printing from Mac OS.*
6 Click Expert Settings in the Print Mode area.

The ColorWise Expert Settings dialog box appears.

7 Choose the custom simulation profile from the CMYK Simulation Profile menu.

Make sure to choose the simulation profile you saved after editing the Paper Simulation
White Point values in the previous section.

8 Select the Full (Output GCR) option.

9 Select Paper Simulation.

For more information about the print option, see the following section.

10 Choose the output profile that you have linked to the custom simulation profile.

11 Click OK.

The ColorWise pane reappears.

12 Click OK to close the Properties dialog box.

13 Click Print.

The job is printed using your custom CMYK Simulation Profile with the edited
White Point values.
In addition to managing “named” colors (spot colors and custom colors), Spot-On allows you to create a list of “substitute” colors with Fiery Graphic Arts Package. These are colors that, when called for in a document by their RGB or CMYK values, are substituted with a different color having the CMYK values from the Spot-On color dictionary. This permits exact color control and overrides individual RGB and CMYK colors.

**NOTE:** Color substitutions affect only text, vector, and line art. They have no effect on raster images.

**NOTE:** When a color is defined as a substitute color, the settings for an RGB color (such as RGB Source, Rendering Style, and RGB Separation) or CMYK color (such as CMYK Simulation Profile, CMYK Simulation Method, and Paper Simulation) have no effect. It is converted with the similar process as a spot color.

For information about managing named colors, see *Color Printing*.

### Substitute Colors workflow

The substitute color workflow involves defining the substitute color values with Spot-On, and then printing a document with the Substitute Colors print option set to On from the printer driver. You can also change the print option setting using Command WorkStation overrides.

**NOTE:** You cannot use the Substitute Colors and Postflight features at the same time. These print options are constrained from the printer driver.

### Creating a color for substitution

Use the following procedure to add a new substitute color in a substitute group and specify the value-name for a color to substitute.

**NOTE:** A new substitute color can be added only to a substitute group.
To add a new substitute color and specify the value-name for substitution

1. Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.

   **NOTE:** Start ColorWise Pro Tools from a stand-alone application or Command WorkStation, at your computer or at the monitor connected to the Fiery EXP6000/EXP5000.

2. Click Spot-On.

   The Select Output Profile dialog box appears.

3. Choose an output profile and click OK.

   The Spot-On main dialog box appears.

   **NOTE:** When you print a job, choose the same output profile from the printer driver as the one that is selected in the Select Output Profile dialog box. Otherwise, color adjustments based on Spot-On have no effect.
4 Select the location in the group list where you want the addition to be placed.

5 Choose New Substitute Group from the Edit menu.

A new substitute group entry appears as Untitled.

6 Double-click the word “Untitled” and type a new name.

7 Select the substitute group and choose New Substitute Color from the Edit menu.

**NOTE:** If the substitute group already contains substitute colors, select the color above the location where you want to add a new substitute color.

The Add Substitute Color dialog box appears.

8 Select a color mode for the substitute color.

9 Select a tolerance degree for the substitute color.

For information about Tolerance, see pages 32 through 33.

10 Type the values for the color you want to substitute.

11 Click OK.

The substitute color appears at the specified location.

**Defining the color values for a substitute color**

After you specify the original color to substitute, define CMYK values for the substitute color by typing the exact CMYK values in the Spot-On main window or Set Center Patch Color dialog box, or use Spot-On Color Search.

For instructions on defining a substitute color by typing the exact CMYK values, see the following sections. To define a substitute color in the Spot-On Color Search dialog box, see page 30.
TO DEFINE A SUBSTITUTE COLOR IN THE SPOT-ON MAIN WINDOW

1 Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.

2 Click Spot-On.

The Select Output Profile dialog box appears.

3 Choose an output profile and click OK.

The Spot-On main dialog box appears.

4 Select the color that you want to substitute.

5 Double-click the value under C, M, Y, and K, and type a new number for each color channel.

The new values for the substitute color appear in the color list.

NOTE: The edited color is not saved until you choose Save from the File menu.

TO DEFINE A SUBSTITUTE COLOR IN SET CENTER PATCH COLOR

1 Select the color that you want to substitute.

2 Double-click the color icon.
The Spot-On Color Search dialog box appears with the selected color in the center.

1. Center patch

2. Click the center patch.

   The Set Center Patch Color dialog box appears.

3. Type values for each C, M, Y, and K color channel.

   For information about using Set Center Patch Color, see Color Printing.

4. Click OK.

   The new color appears in the center in the Spot-On Color Search dialog box.

5. Click OK.

   The new color appears in the color list of the Spot-On main window.

   **NOTE:** The edited color is not saved until you choose Save from the File menu.

   Use the following procedure to target a substitute color using the Spot-On Color Search dialog box.
To define a substitute color using Spot-On Color Search

1 Select the color that you want to substitute.

2 Double-click the color icon.

The Spot-On Color Search dialog box appears, displaying the current color in the center.

3 Click neighboring patches until you find the color that you want to use for the substitution.

For more information about using Spot-On Color Search, see Color Printing.

4 Click OK.

The new substitute color appears in the color list of the Spot-On main window.

NOTE: The edited color is not saved until you choose Save from the File menu.

Printing a job with a substitute color

After you define CMYK values for substitution in Spot-On, you can print a document with the substitute color from the printer driver. You can also override the print option setting using Command WorkStation.

NOTE: The procedures for printing a job from a Mac OS and a Windows computer are similar.

To print a job with a substitute color

1 Open a document in your application.

2 Choose Print.

3 Select Fiery EXP6000/EXP5000 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
4 Click the ColorWise print option bar.

![ColorWise print option bar]

5 Choose On from the Substitute Colors menu.

6 Click Print.

   The job is printed with the substitute you defined in Spot-On.

**Substitute Color dialog box**

Define the color mode and tolerance range for a substitute color in the Add Substitute Color or Rename Substitute Color dialog box.

![Add Substitute Color dialog box]

**NOTE:** The Add Substitute Color dialog box appears when you choose Edit> New Substitute Color after selecting a substitute color group in the list. The Rename Substitute Color dialog box appears when you double-click the bracketed section of a substitute color.

**NOTE:** The Add Substitute Color and Rename Substitute Color dialog boxes offer the same control in defining a substitute color.
• **Substitute Color:** Select the following color modes for a substitute color:
  - CMYK (0-100%)
  - RGB (Device Code 0-255)
  - RGB (0-100%)

• **Tolerance:** Select the following tolerance ranges for a substitute color:
  - Small (indicated in lowercase)
  - Large (indicated in uppercase)

To avoid entry errors, the Add Substitute Color and Edit Substitute Color dialog boxes display the values in the following predefined formats. The dialog boxes also display uppercase or lowercase characters and a “%” symbol, depending on the selections.

• **CMYK (0-100%) mode**
  - Small: `<0%c, “0”%m, “0”%y, “0”%k>`
  - Large: `<0%C, “0”%M, “0”%Y, “0”%K>`

• **RGB (Device Code 0-255) mode**
  - Small: `<0”r, “0” g, “0”b>`
  - Large: `<0”R, “0”G, “0”B>`

• **RGB (0-100%) mode**
  - Small: `<0”%r, “0”%g, “0”%b>`
  - Large: `<0”%R, “0”%G, “0”%B>`
Principles for Substitute Colors

In setting the values for Substitute Colors, keep in mind the following principles.

Tolerance range

The accuracy of the substitute color is affected by various elements, such as applications, operating systems, printer drivers, and distilling processes. To accommodate the “errors” that occur because of the rounding rules between the numbers entered by users and the numbers received by the Fiery EXP6000/EXP5000, the options of the small and large tolerance ranges are provided for color substitution.

The following table provides Small and Large substitution tolerance ranges for each color mode.

<table>
<thead>
<tr>
<th>Color mode</th>
<th>Small tolerance range</th>
<th>Large tolerance range</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMYK (0-100%)</td>
<td>+/- 0.25%</td>
<td>+/- 0.5%</td>
</tr>
<tr>
<td>RGB (Device Code 0-255)</td>
<td>+/- 0.25</td>
<td>+/- 1</td>
</tr>
<tr>
<td>RGB (0-100%)</td>
<td>+/- 0.25%</td>
<td>+/- 0.5%</td>
</tr>
</tbody>
</table>

**Note:** Values for tolerance ranges are approximate.

- **CMYK (0-100%)**
  - Small: A substitute color replaces any color that falls within the nearest +/- 0.25% of the color value entered.
  - Large: A substitute color replaces any color that falls within the nearest +/- 0.5% of the color value entered.

- **RGB (Device Code 0-255)**
  - Small: A substitute color replaces any color that falls within the nearest +/- 0.25 of the color value entered.
  - Large: A substitute color replaces any color that falls within the nearest +/- 1 of the color value entered.

- **RGB (0-100%)**
  - Small: A substitute color replaces any color that falls within the nearest +/-0.25% of the color value after scaling.
  - Large: A substitute color replaces any color that falls within the nearest +/-0.5% of the color value after scaling.
**Color substitution**

A color substitution takes place when a substitute color is defined with a different set of CMYK values for the same value-name as the original color.

The following color examples show how a substitution works.

- **Original color**: <100, 0, 0, 0> for the CMYK values (cyan)
- **Substitute 1**: <0, 100, 100, 0> (red)
- **Substitute 2**: <100, 0, 100, 0> (green)

**NOTE:** In the examples, the extreme values and terms “red” and “green” are used for illustrative purposes only.

The following table shows color substitution with different sets of CMYK values assigned to the same original color.

<table>
<thead>
<tr>
<th>Substitution value-name</th>
<th>CMYK values</th>
<th>Before substitution</th>
<th>After substitution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original color</td>
<td>—</td>
<td>&lt;100, 0, 0, 0&gt;</td>
<td>—</td>
</tr>
<tr>
<td>Substitute 1</td>
<td>&lt;100.0c, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;0, 100, 100, 0&gt;</td>
<td>cyan</td>
</tr>
<tr>
<td>Substitute 2</td>
<td>&lt;100.0c, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;100, 0, 100, 0&gt;</td>
<td>cyan</td>
</tr>
</tbody>
</table>

**Priority scheme**

If two substitute colors are defined with the same value-names, but with different sets of CMYK values and different tolerance ranges, Spot-On resolves the priority of substitution according to the order of color in the group.

Spot-On process color substitution is based on the order of color in the group. The color entries at the top of the list have priority over the colors at the bottom of the list. Spot-On scans the list from top to bottom and processes substitution in linear order. When a color is remapped, it is not overridden by any subsequent substitution call.

The following color examples show how the priority scheme works.

- **Original color**: <100, 0, 0, 0> for the CMYK values (cyan)
- **Substitute 3**: <0, 100, 100, 0> (red) with a small tolerance
- **Substitute 4**: <100, 0, 100, 0> (green) with a large tolerance
**NOTE:** In the examples, the extreme values and terms “red” and “green” are used for illustrative purposes only.

**Order of the colors**
- **Case 1:** Substitute 3 (red) is higher than Substitute 4 (green) in the list.
- **Case 2:** Substitute 4 (green) is higher than Substitute 3 (red) in the list.

The following table shows the scheme of priority when the same value-names are assigned to the original color with different sets of CMYK values and different tolerance ranges.

<table>
<thead>
<tr>
<th>Color order</th>
<th>Substitution value-name</th>
<th>CMYK values Before substitution</th>
<th>After substitution</th>
<th>Before substitution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original color</td>
<td>&lt;100, 0, 0, 0&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case 1</td>
<td>Substitute 3</td>
<td>&lt;100.0C, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;0, 100, 100, 0&gt;</td>
<td>cyan</td>
</tr>
<tr>
<td></td>
<td>Substitute 4</td>
<td>&lt;100.0C, 0.0M, 0.0Y, 0.0Kc&gt;</td>
<td>&lt;100, 0, 100, 0&gt;</td>
<td>red (see following)</td>
</tr>
<tr>
<td>Case 2</td>
<td>Substitute 4</td>
<td>&lt;100.0C, 0.0m, 0.0Y, 0.0k&gt;</td>
<td>&lt;100, 0, 100, 0&gt;</td>
<td>cyan</td>
</tr>
<tr>
<td></td>
<td>Substitute 3</td>
<td>&lt;100.0C, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;0, 100, 100, 0&gt;</td>
<td>green (see following)</td>
</tr>
</tbody>
</table>

Substitute 3 and Substitute 4 have the same value-names, but depending on their order in the list, Spot-On produces different results.
- In Case 1, Substitute 3 is given higher priority because it is higher in the list. Subsequently, substitution with Substitute 4 takes place because its tolerance range is larger.
- In Case 2, Substitute 4 is given higher priority because it is higher in the list. No subsequent substitution with Substitute 3 takes place because its tolerance range is smaller.

**Uploading and downloading a substitute color group**

Like named color groups, you can upload or download a substitute color group as an ICC profile. The substitute color definitions are saved with private tags as part of an ICC profile, allowing you to export the Substitution Group definitions between multiple print servers. However, Substitution Group definitions are recognized only by a Fiery EXP6000/EXP5000 with Fiery Graphic Arts Package enabled.
With Fiery Graphic Arts Package, Premium Edition, ColorWise Pro Tools Color Setup offers the following customizable features, in addition to the Color Process Flow feature:

• Control Bar
• Auto Trapping
• Progressives

For information about Color Process Flow, see Color Printing.

The ColorWise Pro Tools applications for Windows and Mac OS computers are similar.

ColorWise Pro Tools Color Setup

Access the Control Bar, Auto Trapping, and Progressives features from Color Setup.

For information about these features, see the following sections:

• Control Bar (see page 38)
• Auto Trapping (see page 46)
• Progressives (see page 50)

Using Color Setup

Use the following procedure to start Color Setup.

NOTE: For information about installing ColorWise Pro Tools and configuring a connection, see Color Printing.
To start Color Setup

1. Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.

   **NOTE:** Start ColorWise Pro Tools from a stand-alone application or Command WorkStation, at your computer or at the monitor connected to the Fiery EXP6000/EXP5000.

2. Click Color Setup.

   The Color Setup main window appears with the Color Process Flow tab selected.
**Control Bar**

Control Bar allows you to add a static color bar and dynamic job information to each printed page at the user-defined location. Add a Control Bar at print time. The feature can be set as a server default or overridden on a per-job basis.

The default Control Bar is designed to fit the Fiery EXP6000/EXP5000’s default paper size, Letter /A4, or larger. You can create Control Bars for other paper sizes.

**NOTE:** If a Control Bar does not fit on the page, it will be clipped.

**NOTE:** If a background color is defined as “white,” it must be defined in the CMYK color space for the Paper Simulation feature to take effect. For more information about Paper Simulation, see page 16.

**Control Bar workflow**

The default Control Bar provides a color bar and dynamic job information. Print a job with the default Control Bar by setting the Control Bar print option to On from the printer driver. Many jobs print satisfactorily with the default Control Bar, but if you require your own color bars, create them by defining custom values in the Control Bar Definition dialog box. After you define a custom Control Bar in the Control Bar pane in Color Setup, you can print a job with the custom Control Bar from the printer driver.

To print a job with the default Control Bar, see the following section. For information about the Control Bar pane, see page 40. To create your own Control Bars, see page 41. To print a job with a custom Control Bar, see page 45.

**Printing with default Control Bar**

Print a job with the default Control Bar by setting the Control Bar print option to On from the printer driver.

---

**To print a job with the default Control Bar**

1. Choose Print from your application.

2. Select Fiery EXP6000/EXP5000 as your printer and click Properties.

   The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the Reporting print option bar.

4 Choose On from the Control Bar menu.

5 Click OK.

6 Click Print.

The job is printed with the default Control Bar.
Control Bar pane

Access the Control Bar pane by clicking the Control Bar tab in the ColorWise Pro Tools Color Setup dialog box (see page 41).

The Control Bar tab allows you to do the following:

- Set the Print Control Bar option to On (see the following section).
- View the definition of a Control Bar (see page 41).
- Define a new Control Bar (see page 41).
- Edit a Control Bar (see page 44).
- Duplicate a Control Bar (see page 44).
- Delete a Control Bar (see page 45).
- Restore the factory default values (see page 45).
Setting the Print Control Bar option to On

Selecting the Print Control Bar option sets the Printer’s Default value to On. If this option is selected, a Control Bar is printed on all pages sent to the Fiery EXP6000/EXP5000 when Printer’s default is selected from the printer driver or with Command WorkStation.

Viewing the definition of a Control Bar

Selecting a Control Bar in the Available Control Bar list allows you to view the settings information in the Control Bar Definition area. With this feature, you can identify the Control Bar without opening the Control Bar Definition dialog box.

The following information is displayed in the Control Bar Definition area:

- Color Bar EPS File
- Job Information
- Text Location
- Distance from edge

Defining a new Control Bar

When you open the Control Bar pane for the first time, only the default Control Bar is available in the Control Bar Definition dialog box. You can create a custom Control Bar that better fits your needs.

Use the following procedure to access the Control Bar pane and create a new Control Bar.

**To create a custom Control Bar**

1. Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.
2. Click Color Setup.
3. Click the Control Bar tab.
4. Click New in the Control Bar pane.
   The Control Bar Definition dialog box appears.
5. Define the values for each option.
   For information about Control Bar options, see “Defining a new Control Bar” on page 41.
6. Click OK.
   A custom Control Bar is created.
The Control Bar Definition dialog box.

The explanation of each section in the Control Bar Definition main window is as follows:

NOTE: The Control Bar Definition dialog box is displayed when you click New in the Color Setup dialog box.

NOTE: Each field of this dialog box initially displays the value from the Control Bar that is currently set as default, except for the System Page Size.

• **System Page Size**: A System Page Size label with two numbers is printed with each Control Bar. These numbers are the exact numbers to enter when creating a custom Control Bar. Every page produced by the Fiery EXP6000/EXP5000 has a System Page Size. These two numbers represent the width and height of the page, in points, as processed by the system. The page sizes that are not defined use the Default system Control Bar.

To find the System Page Size for a job, see a previously printed Control Bar on a document using the targeted paper size and orientation.

• **Description**: This field allows you to add a one-line description of the custom Control Bar for your future reference.
• **Control Bar EPS File:** This option allows you to select the following:
  - Standard: (provided as a default)
  - Custom: (user-designed EPS)
  - None: (no EPS file is required)

  The EPS file contains a color bar and any logo or static information you want to include on the page.

• **Job Information:** The options vary, but typically the following information is available:
  - Page Size
  - Control Bar Name
  - User Name
  - Job Title
  - Date/Time
  - Server Name
  - Printer
  - Calibration Date/Time
  - Output Profile
  - RGB Source Profile
  - RGB Separation
  - Rendering Style
  - CMYK Simulation Profile
  - CMYK Simulation Method
  - Paper Simulation
  - Spot Color Matching
  - Pure Black Text/Graphics
  - Black Overprint
  - Group Name
  - Notes
  - Instructions
• **Text Location**: This menu allows you to choose the location in which you want the job information printed on the page:
  - Bottom
  - Left
  - Top
  - Right

For the location and orientation of the job information, see the following illustration.

![Illustration of text location options]

• **Distance from the edge**: This text field allows you to define the distance from the lower-left corner at which you want the job information to begin printing. The settings to define are as follows:
  - **Units**: Choose inches, millimeters, or points from the Units menu.
  - **Horizontal**: Type the value.
  - **Vertical**: Type the value.

**Editing a Control Bar**

You can edit all of the values in the Control Bar Definition dialog box, with the exception of System Page Size, which appears dimmed.

The System Page Size for the default Control Bar refers to different system page sizes. For other Control Bars, values are displayed in the text field.

**NOTE**: To display the Control Bar Definition dialog box for editing, select a Control Bar in the Available Control Bar list, and then click Edit.

**Duplicating a Control Bar**

When you duplicate a Control Bar, all the values of the original Control Bar are displayed. You can edit and save the duplicate as a custom Control Bar.

If you edit and save a Control Bar as a custom Control Bar, you must change the System Page Size values. No two Control Bars can use the same values. If you try to save the custom Control Bar without changing the System Page Size values, a warning message appears.
Because a Control Bar is not a part of a job, a document may be printed with one Control Bar, and then be reprinted later, with another Control Bar, if the Control Bar definition has changed. To keep the Control Bar and reuse it later, you must save the changes as a custom Control Bar.

**Note:** To display the Control Bar Definition dialog box for duplicating, select a Control Bar in the Available Control Bar list and click Duplicate.

**Deleting a Control Bar**

You can delete a Control Bar from the list in the Available Control Bar dialog box. You are prompted to confirm the deletion.

**Note:** You cannot delete the default Control Bar.

**Restoring the factory default values**

The Control Bar Definition dialog box allows you to delete all user-defined Control Bars and restore the default Control Bar to its original state by clicking Factory Defaults.

**Printing with a custom Control Bar**

The procedure to print a job with a custom Control Bar is basically the same as to print with the default Control Bar (see page 38). Use the following procedure to print with a custom Control Bar.

---

**To print a job with a custom Control Bar**

1. Choose Print from your application.
2. Select Fiery EXP6000/EXP5000 as your printer and click Properties.
   
   The Properties dialog box appears with the Fiery Printing tab selected.
3. Click the Reporting print option bar.
4. Choose On from the Control Bar menu.
   
   **Note:** Selecting On from the printer driver affects the current job only. If you selected Print Control Bar in the Control Bar pane, selecting Printer’s Default has the same effect as On. Selecting Print Control Bar in the Control Bar pane sets the default value to On for all jobs.
5. Click OK.
6. Click Print.
   
   The job is printed with the Control Bar specified in the Control Bar Definition dialog box.
Configurable Auto Trapping

Trapping is a technique where some objects are printed slightly larger or smaller than you have specified in an application, in order to prevent white edges around the objects. These white edges, or “gaps,” are the result of misregistration, the physical properties of the toner, or stiff media.

The configurable Auto Trapping feature provides you with advanced trapping settings and gives you full control over their values. The Fiery EXP6000/EXP5000 is shipped with values that are optimized for a Fiery-driven print device using regular paper, but if these values do not provide the results necessary for the media that you use, you can modify the values to meet your requirements.

Configurable Auto Trapping workflow

The fixed values are set as default for Auto Trapping. The Fiery EXP6000/EXP5000 applies these fixed values when you set Auto Trapping to On with generally good results. However, to customize the values for Auto Trapping, define the values in the Auto Trapping pane in Color Setup. After you define the values, print a job with Auto Trapping set to On from the printer driver.

Printing with default Auto Trapping

You can print a job with default Auto Trapping by setting the Auto Trapping print option to On from the printer driver.

To Print a Job with Default Auto Trapping

1. Choose Print from your application.
2. Select Fiery EXP6000/EXP5000 as your printer and click Properties.
   The Properties dialog box appears with the Fiery Printing tab selected.
3. Click the Image Quality print option bar.
4. Choose On from the Auto Trapping menu.
5 Click OK.
6 Click Print.

The job is printed with the default Auto Trapping values.

**Auto Trapping pane**

Access the Auto Trapping pane by clicking the Auto Trapping tab in the ColorWise Pro Tools Color Setup dialog box (see page 49).

The settings in the Auto Trapping pane allow you to perform the following tasks:
- Set the Apply Auto Trapping option to On (see the following section)
- Specify the trap width (see page 48)
- Specify the trap color reduction (see page 48)
- Specify the trap shape (see page 48)
- Specify the trap object types (see page 49)
- Restore the factory default values (see page 49)

**Setting the Apply Auto Trapping option to On**

When you select the Apply Auto Trapping option, you set the Printer's default value to On. If the option is selected, the configured auto trapping is applied to all jobs sent to the Fiery EXP6000/EXP5000, when you select Printer's Default from the printer driver or use Command WorkStation.
Specifying Trap Width
Trap Width values determine how thick the trapped areas are. Specify the following values:

- **Horizontal**: Defines the horizontal thickness of the trapped areas (0-10 pixels).
- **Vertical**: Defines the vertical thickness of the trapped areas (0-10 pixels).

When you select the Uniform option, the horizontal and vertical Trap Width values are the same. If the values were set before you selected Uniform, the higher of the two values is used for both.

A small bitmap image in the lower-left corner of the Trap/Width pane provides a dynamic visual example of the selected values.

Specifying Trap Color Reduction
Trap Color Reduction values determine how intense the trapping effect is. The values entered reflect the percent reduction of the toner in the trap. You can enter values for the following color channels:

- **Cyan**: Defines the trap reduction in cyan (0-100%).
- **Magenta**: Defines the trap reduction in magenta (0-100%).
- **Yellow**: Defines the trap reduction in yellow (0-100%).
- **Black**: Defines the trap reduction in black (0-100%).

A 100% reduction results in no toner intensity applied to the trap. A 0% reduction results in full toner intensity.

When you select the Uniform option, all four trap Color Reduction values are the same. If the values were set before you selected Uniform, the highest value is used for all.

A small bitmap image to the left of each color in the Trap Color Reduction pane provides dynamic visual examples of the selected values.

Specifying Trap Shape
Trap Shape represents how a single pixel appears when trapped against a contrasting background. With elements bigger than one pixel, the shape, or part of the shape, is only visible at the corners of objects. Select any of the following shapes:

- Ellipse
- Diamond
- Rectangle
Specifying Trap Object Types
When no option is selected in the Trap Object Types area, only trapping of objects (text and graphics) against objects is applied. Select any of the following:

- **Trap Objects to Images**: Auto trapping is applied to boundary areas between objects and images.
- **Trap Images Internally**: Auto trapping is applied to every individual pixel of an image.

This option is available only when you select Trap Objects to Images. If the Trap Objects to Images option is cleared, the Trap Images Internally option appears dimmed.

Restoring Factory Defaults
Click Factory Defaults to delete all user-defined settings for Auto Trapping and restore the factory default settings.

Defining custom values for Auto Trapping
Use the following procedure to select the Auto Trapping settings and define custom values.

**To define Auto Trapping values**

1. Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.
2. Click Color Setup.
3. Click the Auto Trapping tab.
4. Define a value for each option in the Auto Trapping pane.
   - For information about the options in the Auto Trapping pane, see page 47.
5. Click Apply.
   - The defined Auto Trapping values are applied.

Printing a job with the configurable Auto Trapping feature
After you define the Auto Trapping values, print a job with the Auto Trapping feature by setting the Auto Trapping print option to On from the printer driver. You can change the setting for this print option using Command WorkStation.

**Note**: If the Auto Trapping values are changed, reRIPping is required to print a job with the new values.

Use the procedure on page 38 to print a job with custom Auto Trapping values from the printer driver.

**Note**: Selecting On from the printer driver affects the current job only. Selecting Apply Auto Trapping in the Auto Trapping pane in Color Setup sets the default value for all jobs, and allows you to select Printer’s default from the printer driver.

The job is printed with the Auto Trapping values defined in the Auto Trapping pane.
About Progressives

The term “Progressives” refers to printing variations in a multi-color document. The variations may use from one to all of the available color channels in a print device. The majority of printing processes that involve more than one or two colorants apply the colorants sequentially. Traditionally, progressives are the intermediate states after some and before all colorants have been applied. The Progressives feature is more flexible, because it allows you to choose which color is printed, using up to four sheets per original document page.

**NOTE:** The Progressives feature is designed to show you the toner separations used by the job on the print device. The feature is not intended to be used to proof for another non-Fiery driven print device.

**NOTE:** Progressives show the separations that the Fiery EXP6000/EXP5000 sends to the print device, not the separations contained in the job source file.

Progressives workflow

You can inspect the result of each channel with the default values for color channels in Progressives. However, if you must customize the selection of color channels or number of sheets to print, you can do so by specifying the color channels in the Progressives pane in Color Setup. After specifying the color channels, print a job with the customized Progressives by setting the print option to On from the printer driver.

**NOTE:** You cannot use the Progressives and Postflight features at the same time. A constraint is set for these print options from the printer driver.

**NOTE:** Clearing plates in ImageViewer does not have an effect on a Progressives job printed from ImageViewer. It prints with the values specified in the Progressives pane. For more information about ImageViewer, see “EFI ImageViewer” on page 57.
Printing a job with default Progressives

Print a job with default Progressives by setting the Progressives print option to On from the printer driver.

TO PRINT A JOB WITH DEFAULT PROGRESSIVES

1. Choose Print from your application.
2. Select Fiery EXP6000/EXP5000 as your printer and click Properties.

   The Properties dialog box appears with the Fiery Printing tab selected.
3. Click the Reporting print option bar.

4. Select On in the Progressives area.
5. Click OK.
6. Click Print.

   The job is printed with the default Progressives.
Progressives pane

Access the Progressives pane by clicking the Progressives tab in ColorWise Pro Tools Color Setup. For more information about accessing the pane, see the procedure on page 53.

The settings in the Progressives pane allow you to do the following:

- Specify sheets (1-4) and colors per sheet to print (see the following section).
- Restore the factory default values (see page 53).

Specifying sheets and colors

At least one colorant (Cyan, Magenta, Yellow, or Black) must be selected for each sheet and at least one sheet must be selected.

Small bitmap images to the left of each row dynamically change to reflect your selections.
Restoring Factory Defaults

Clicking Factory Defaults allows you to delete all user-defined settings for the Progressives feature and restore the default settings.

Factory default values are set as follows:

- Sheet 1: Black
- Sheet 2: Black + Cyan
- Sheet 3: Black + Cyan + Magenta
- Sheet 4: Black + Cyan + Magenta + Yellow

These selections are arbitrary, independent of the source job and the printing order of the digital press. With this selection, the first sheet includes the black plate only, because it is often the most important plate when looking at separations. The other colors are added in a “progressive” order.

When you return to the Progressives tab, the set of selections you last made is displayed.

The colors included do not have to represent the actual sequence applied by the digital press, which provides more flexibility for analyzing the image composition.

Specifying color channels

Use the following procedure to access the Progressives pane and specify color channels.

To access the pane and specify color channels

1. Start ColorWise Pro Tools and connect to the Fiery EXP6000/EXP5000.
2. Click Color Setup.
3. Click the Progressives tab.
4. Specify the color channels in the Progressives pane.
   For information about the options in the Progressives pane, see page 52.
5. Click Apply.

The specified color channels are applied.

Printing a job with custom Progressives

After specifying the color channels, print a job with custom Progressives by setting the Progressives print option to On from the printer driver. You can change the print option setting using Command WorkStation.

Use the procedure in page 51 to print a job with the custom Progressives feature from the printer driver.

The printed job reflects the Progressives settings you defined in the Progressives pane.
The Soft Proofing feature allows you to view accurate color previews of print jobs on a monitor. Use soft proofs to preview colors as they will appear when the job is printed.

**NOTE:** Access Soft Proofing through Command WorkStation.

**Viewing soft proofs**

The Soft Proofing feature applies a specified color profile to the preview of a job to compensate for the unique display characteristics of your monitor. As a result, the preview provides a more accurate representation of how the job will appear when printed.

**To view a soft proof of a job**

1. In the Active Jobs window of Command WorkStation, select the job that you want to soft proof.

2. Soft Proofing is supported only for jobs that show processed/held (dark yellow) status.

3. If needed, choose Process and Hold from the Actions menu to move the job to processed/held status.

4. Choose Preview from the Actions menu.

Page thumbnails appear in the Preview window.
5 Select the thumbnail of the page that you want to soft proof, and click the Full-Screen Preview button.

The full-screen preview may take a few moments to open. The full-screen preview window is independent of and may appear behind the application on the screen. Bring the full-screen preview window to the front, if necessary.

6 Select the Soft Proof option.

A dialog box prompts you to select a monitor profile.

7 Locate and select the monitor profile for your monitor.

Be sure to select a profile customized for the characteristics of your monitor. Otherwise, the soft proof will not be accurate. Also, be sure to configure the monitor display according to the manufacturer's recommended settings. For information about monitor profile, see page 15.
8 Click Open.

The full-screen preview now displays a soft proof of the original job, as interpreted through the monitor profile you specified.

9 To change the monitor profile used for the soft proof, click the Load button next to the profile name in the full-screen preview window.

In the dialog box that appears, locate and select the new monitor profile, and then click Open.
EFI ImageViewer

EFI ImageViewer allows you to soft proof and adjust colors in a job before it is printed. You can use the preview in ImageViewer to verify job placement, orientation, and content, as well as general color accuracy. If the job contains halftone screened settings, the preview shows a composite view of all separations at the dot level. You can choose to display the plate data for each process color independently or in combination with the other colors, allowing inspection of individual plate data or a combination of any range of plates.

Accessing ImageViewer

Start ImageViewer from either the Actions menu or Preview window of Command WorkStation, Windows Edition.

To start ImageViewer from the Actions menu

1 In the Active Jobs window of Command WorkStation, select the job that you want to preview.

**Note:** ImageViewer recognizes only jobs that show processed/held (dark yellow) status. Processed/held jobs are also indicated by the raster job icon (page icon ringed with a halo).

2 If needed, choose Process and Hold from the Actions menu to move the job to processed/held status.

3 To start ImageViewer, do one of the following:
   - Choose Launch ImageViewer from the Actions menu.
   - Right-click the selected job and choose Launch ImageViewer from the menu that appears.

The ImageViewer main window appears.
TO START ImageViewer FROM THE Preview WINDOW

1. In the Active Jobs window of Command WorkStation, select the job that you want to preview.

   **NOTE:** ImageViewer recognizes only jobs that show processed/held (dark yellow) status.

2. If needed, choose Process and Hold from the Actions menu to move the job to processed/held status.

3. Choose Preview from the Actions menu.

   Page thumbnails appear in the Preview window.

4. Do one of the following to start ImageViewer:
   - Select the thumbnail of the page that you want to soft proof, and click the Full-Screen Preview button.
   - Double-click the thumbnail of the page you want to soft proof.

   The ImageViewer main window appears.
ImageViewer main window

The following illustration identifies the components of the ImageViewer main window.

1. Toolbar
2. Navigator pane
3. Thumbnail preview
4. Image preview
5. Color adjust pane
6. Separations pane
7. Job information bar

To expand and collapse the Navigator, Color Adjust, or Separations panes, click the triangle in the title bar of the pane. To expand and collapse all the panes at once, click the triangle to the left of the Image Preview pane.

The following sections describe the components and their functions.

Menu commands

ImageViewer provides the following menus of commands:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open</td>
<td>This command is disabled.</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Closes the active viewer data and clears the viewer thumbnail and display window.</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Saves the image with the current color adjustments you have made.</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Allows you to save the image with a different file name.</td>
</tr>
<tr>
<td></td>
<td>Revert</td>
<td>Reverts the image to its last saved state.</td>
</tr>
<tr>
<td></td>
<td>Import</td>
<td>Imports saved color adjustment settings into the Color Adjust pane.</td>
</tr>
<tr>
<td></td>
<td>Export</td>
<td>Allows you to export the current Color Adjust settings to a file.</td>
</tr>
</tbody>
</table>
### Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Sends the image to print on the Fiery EXP6000/EXP5000.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes and exits ImageViewer.</td>
</tr>
<tr>
<td>Color Adjust</td>
<td>Allows you to copy color adjustments to the current page and paste them to another page. Paste All pastes the adjustments to all the pages in the image file.</td>
</tr>
<tr>
<td>Preferences</td>
<td>Allows you to set Resolution and Dimension units and the Monitor Profile. For more information, see “To set preferences” on page 60.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotates the image in 90-degree increments.</td>
</tr>
<tr>
<td>Separations</td>
<td>Allows you to change the selection of separations displayed in the Image Preview (see “Separations pane” on page 65).</td>
</tr>
<tr>
<td>Previous/Next</td>
<td>Displays the previous or next page in the image file.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Changes the zoom setting to a higher percentage to show more detail.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Changes the zoom setting to a lower percentage to show the overall image.</td>
</tr>
<tr>
<td>Actual Pixels</td>
<td>Displays each pixel of image data as one screen pixel in the Viewer window. If the job has halftone settings, each halftone dot is displayed as one screen pixel.</td>
</tr>
<tr>
<td>Navigator/Color Adjust/Separations</td>
<td>Toggles the display of the corresponding pane in the ImageViewer window.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Displays ImageViewer in Full Screen without menus or the toolbar. Press F11 or Esc to exit out of Full Screen mode.</td>
</tr>
</tbody>
</table>

## Help

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Displays version information about ImageViewer.</td>
</tr>
</tbody>
</table>

### To set preferences

1. **Choose Preferences from the Edit menu.**

The Preferences dialog box appears.
2 Specify the following preferences:

**Units: Resolution**: Defines the measurement unit for displaying the viewer data resolution. Possible choices are: inches, mm, or cm.

**Units: Dimensions**: Defines the measurement unit for displaying the size of the viewer data image. Possible choices are: inches, mm, cm, points, or pixels.

**Monitor Profile**: Sets the monitor profile for the viewer display to simulate how the viewer data image will print on paper.

3 Click OK.

### Toolbar

The toolbar contains the following tools.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves the edits that you have applied to the job.</td>
</tr>
<tr>
<td>Print</td>
<td>Sends the job to print. In the Print dialog box, specify the Range of pages to print: All prints all pages; Current prints only the page currently displayed in ImageViewer. The printed page(s) include composite color information for the separations that are currently selected in the Separations pane.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotates the preview 90° clockwise. The rotation applies to the preview display only. The orientation of the printed job does not change.</td>
</tr>
<tr>
<td>Cross Hair Color Picker</td>
<td>Allows you to change the color of the bounding box in the Navigator pane and the navigation target in the Image Preview. For more information, see the following procedure.</td>
</tr>
<tr>
<td>Previous/Next</td>
<td>Switches the preview to the previous or next page in the job.</td>
</tr>
</tbody>
</table>
To change the color of the bounding box and navigation target

1. Click the Cross Hair Color Picker in the toolbar.

The Cross Hair Color Picker dialog box appears.

2. To choose one of the Basic colors, click a color.

3. To create a Custom color, move the cursor over the color swatches to create a color, or type values in the fields. Click Add to Custom Colors.

4. After selecting a Basic or Custom color, click OK to change the color of the bounding box.

Navigator pane

The Navigator pane displays a thumbnail preview of the image. It provides controls for specifying the viewing area of the image and zooming in or out.

Bounding box

The bounding box in the Navigator pane indicates the area of the page that is currently displayed in the Image Preview. Cross Hair Color Picker allows you to change the color of the bounding box.

Thumbnail preview

The thumbnail preview displays the current page. The bounding box indicates the area displayed in the Image Preview.
Use the following guidelines to navigate the image with the bounding box:

- To move quickly to another area of the image, place the cursor on the new location in the thumbnail preview, and click.
- To traverse and move gradually to another area of the image, place the cursor inside the bounding box and drag the bounding box to the desired area.

**Zoom controls**

Zoom in or out on the thumbnail preview to change what is displayed in the viewer window.

---

**TO ZOOM IN OR OUT TO PRESET MAGNIFICATIONS**

- Click the Zoom controls at the bottom of the Navigator pane, or choose Zoom In or Zoom Out from the View menu.

---

**TO ZOOM IN OR OUT IN SMALLER INCREMENTS**

- Drag the slider at the bottom of the Navigator pane.

If your mouse has a scroll wheel, you can also use the scroll wheel to zoom in and out.

**Color Adjust pane**

The Color Adjust pane allows you to edit the colors in a job. The Image Preview changes dynamically as you adjust the colors.

You can edit colors in either Color Wheel or Curves mode. To switch between modes, click the tabs at the bottom of the Color Adjust pane.

**Color Wheel mode**

Color Wheel mode allows you to make general color adjustments to a job by adjusting a target point inside the color wheel. Use the following guidelines:

- Choose the type of adjustment that you want to make from the adjustment menu.
• Click a tone selection button to specify the tonal range affected by the adjustments. The left button confines adjustments to the highlight tones; the right button confines adjustments to the shadow tones; the center button applies adjustments to the entire tonal range.

• Drag the target point inside the color wheel to make color adjustments. Use the Image Preview to monitor the adjustments you are making.

• To control the adjustment using numeric values, drag the numeric slider or enter the value in the numeric field to the left of the slider.

**NOTE:** If you switch to Curves mode after making adjustments in Color Wheel mode, the color curves reflect the adjustments that you made.

### Curves mode

1. **Color selection buttons**

Curves mode allows you to make precise color adjustments to a job by customizing the ink density curve for each color separation. Use the following guidelines:

• To select a curve for editing, click the color selection button for the curve. Click the eye icons below the color selection buttons to show and hide the respective color curves.

• To adjust a curve, drag points on the curve to the desired output density values.

• To delete a point on a curve, select the point and press the Delete key. You cannot delete the 0% highlight point or the 100% shadow point.

**NOTE:** If you switch to Color Wheel mode after adjusting color curves in Curves mode, all of your curve adjustments will be lost.
Separations pane

The Separations pane controls the display of color separations in the Image Preview. It also dynamically displays the ink density values of the colors that are currently beneath the cursor.

1 Ink density values

<table>
<thead>
<tr>
<th>Separation</th>
<th>Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>75%</td>
</tr>
<tr>
<td>Magenta</td>
<td>32%</td>
</tr>
<tr>
<td>Yellow</td>
<td>86%</td>
</tr>
<tr>
<td>Black</td>
<td>84%</td>
</tr>
</tbody>
</table>

Use the following guidelines to control the display of color separations:

- To turn on or off the display of a separation, select or clear the check box next to the separation name. You can also toggle the display of an individual separation by choosing View > Separations, and then choosing the separation name from the submenu.

- To invert the current selection of separations, choose View > Separations > Invert Selection. For example, if Cyan and Magenta are selected when you choose Invert Selection, Yellow and Black are selected and displayed in the Image Preview.

- To quickly display all separations, choose View > Separations > Select All.

- To view the ink density of a particular area of the image, place the cursor over that area in the Image Preview and observe the values that appear next to each separation in the Separations pane.

- To print one plate, or a range of plates, select the plate or plates that you want to print.
Image Preview pane

In addition to navigating around the image in the thumbnail preview, you can navigate using the Image Preview.

Navigation

Use the following guidelines to navigate using the Image Preview:

- To move to a different area of the page, place the cursor inside the Image Preview, click and hold down the mouse button. The cursor turns into a navigation target with an arrow. Drag the mouse slightly to adjust the arrow and move in the desired direction.
- To scroll to a different area of the page, use the scroll bars and arrows along the right and bottom edges of the Image Preview.
- To move to a different page of the job, click the Previous and Next buttons in the toolbar, or enter the desired page number at the top of the Image Preview pane.

Rotation

The rotation controls affect the preview display of the job. The actual printed orientation of the job is unchanged. Use the following guidelines when rotating the display:

- To rotate the preview in 90° clockwise increments, click Rotate in the toolbar.
- To choose the amount of rotation or reset the image display to its default orientation, choose a command from the View>Rotate submenu.

Viewing actual pixels

Choose Actual Pixels from the View menu to display the each pixel of data in the image as a single monitor display pixel.

Full Screen mode

Choose View > Full Screen to display ImageViewer in Full Screen mode, without menus or the toolbar. Maximize the Image Preview even further by clicking the triangle to the left of the title bar to collapse the Navigator, Color Adjust, and Separations panes.

To exit Full Screen mode, press F11 or Esc.
This chapter describes how to configure the EFI Hot Folder filters to convert various files to PS (PostScript) or PDF (Portable Document Format), or to preflight certain files.

For information about operating systems that support Hot Folders, see the Welcome document. For information about installing the Hot Folders application, see Utilities.

For information about using the Hot Folders application, see the online help in Hot Folders Help.

About file conversion

Hot Folders filters allow you to convert certain file formats to PS or PDF or preflight files for conformity. File conversion and preflighting take place on your computer within Hot Folders, which saves Fiery EXP6000/EXP5000 resources. You can print files directly from Hot Folders filters without starting the application from which they were created.

Two types of filters are available: Exclusive and Non-exclusive. A Hot Folder configured with an Exclusive filter processes the defined file type(s). No other file formats, including the default file formats, are processed. When you select an Exclusive filter, you disable all other filters.

Non-exclusive filters allow Hot Folders to accept multiple default file formats, such as PS, PDF, TIFF, and EPS. Non-exclusive filters can also be used with other Non-exclusive filters.

When you configure an Exclusive filter to a Hot Folder, the Hot Folder icon changes, and is renamed to reflect the Exclusive filter.
# Filters

The following table describes the available filters and indicates whether the filter is Exclusive or Non-exclusive:

<table>
<thead>
<tr>
<th>Filter name</th>
<th>Type of filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF/IT to PostScript</td>
<td>Exclusive</td>
<td>Converts TIFF/IT to a pre-separated PostScript file, with one separation per page. TIFF/IT-p1 is a common file format for the transfer of final print job data from one print platform to another. It is a widely used format for prepress preparation in traditional printing environments. For more information about configuring TIFF/IT files, see “Configuring the TIFF/IT to PS filter” on page 72.</td>
</tr>
<tr>
<td>CT/LW to PostScript</td>
<td>Exclusive</td>
<td>Converts multiple CT (Contone), LW (Line Work), or FP (Final Page) files into a single combined PS file. CT/LW files are files that contain information about photographic imagery, line art images, or text and lines from drawings. Together, CT and LW files determine the final output will appear. For more information about configuring CT/LW files, see “Configuring the CT/LW to PS filter” on page 73.</td>
</tr>
<tr>
<td>DCS 2.0 to PostScript</td>
<td>Exclusive</td>
<td>Converts DCS 2.0 files to a pre-separated PS file, with one separation per page. Developed by QuarkXPress, the DCS 2.0 file is a picture format definition for electronic color separations. This plug-in accepts: Single/Multiple file DCS, No composite Single/Multiple file DCS with grayscale composite Single/Multiple file DCS with color composite For more information about configuring DCS 2.0 files, see “Configuring the DCS 2.0 to PS filter” on page 74.</td>
</tr>
<tr>
<td>ExportPS</td>
<td>Exclusive</td>
<td>Processes ExportPS files and converts them to PS or PDF files. Developed by Creo-Scitex, the Export PS file is a PS raster output. For more information, see “Configuring ExportPS filter” on page 75.</td>
</tr>
<tr>
<td>PDF2Go</td>
<td>Exclusive</td>
<td>Processes PDF2Go files and converts them to PS or PDF. Developed by Creo-Scitex, the PDF2Go file is a PDF output that contains PDF layers or rasterized CT and LW, each with a different resolution. For more information, see “Configuring the PDF2Go filter” on page 75.</td>
</tr>
<tr>
<td>EPS to PostScript</td>
<td>Exclusive</td>
<td>Converts EPS files to PS and provides options for scaling and positioning the output. For more information, see “Configuring the EPS to PS filter” on page 76.</td>
</tr>
<tr>
<td>Filter name</td>
<td>Type of filter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PDF/X Preflight</td>
<td>Exclusive</td>
<td>Indicates if the PDF job meets PDF/X specifications. This filter allows PDF/X-1a or PDF/X 3-compliant jobs to be downloaded to the Fiery EXP6000/EXP5000. For more information about PDF/X files and configuring these files, see “Configuring the PDF/X Preflight filter” on page 77.</td>
</tr>
<tr>
<td>TIFF to PDF</td>
<td>Non-exclusive</td>
<td>Converts TIFF files to PDF and provides options for scaling and positioning of the output. This filter accepts all TIFF files up to TIFF 6.0. For more information, see “Configuring the TIFF to PDF filter” on page 77.</td>
</tr>
<tr>
<td>JPEG to PDF</td>
<td>Non-exclusive</td>
<td>Converts JPEG files to PDF and provides options for scaling and positioning of the output. For more information, see “Configuring the JPEG to PDF filter” on page 79.</td>
</tr>
</tbody>
</table>
Specifying filter settings for a Hot Folder

After specifying the filter settings and options for your Hot Folder, drag and drop the proper file formats onto your Hot Folder to begin the conversion process.

Open the Filter Settings dialog box from the Folder Properties dialog box.

To select a filter setting

1. From the Hot Folders Control Panel, select the Hot Folder and click Properties.

2. Select Filter Settings and click Define.

   The Filter Settings dialog box appears, allowing you to select the filter and configure the settings.

   Filters are color-coded. Exclusive filters are blue; Non-exclusive filters are black.

3. Select the filter that you want to use for the Hot Folder.

   If you select an Exclusive filter, you cannot select any other filter.

4. Right-click or double-click the filter name and select Properties.

   For more information, see “Configuring the filters” on page 72.

5. To convert all PS files to PDF automatically, select Convert PS to PDF and a job option from the Distiller Profile menu in the PS->PDF Normalizer pane.

   For information about PS->PDF Normalizer, see the following section.

6. Click OK.
About PS->PDF Normalizer

The PS->PDF Normalizer feature offers the Convert PS to PDF option.

NOTE: The Convert PS to PDF option is available only when Acrobat Distiller is installed on the same system as the Hot Folders application. For more information about installing Adobe Acrobat, see Utilities.

Convert PS to PDF

Although many filters output PS by default, this option allows you to further convert PS to PDF. This is a global setting that affects all PS files for a particular Hot Folder. This setting affects all PS output from all filters.

Since Convert PS to PDF affects all PS output files, turning on this setting may not be suitable in certain printing workflows.

For example: Both the DCS 2.0 and TIFF/IT filters output pre-separated PS files, one separation file per page. In order to print these pre-separated files as a composite image, you must select the Combine Separation option in the Job Settings. However, the Combine Separation feature accepts only the PS type files. Selecting the Convert PS to PDF option results in printing multiple grayscale pages, instead of a composite color page of an image.

Distiller Profile

This menu displays all the available Distiller job options. This setting is used to control the quality of the PS to PDF conversion. The Hot Folders application retrieves the job options from the location set by Distiller. If you create and save your custom Distiller job options elsewhere, the custom job options must be manually copied to the Distiller\Settings folder.
Configuring the filters

Certain filters provide extra user control and conversion settings. To access these settings, right-click or double-click the Plugin Name in the Filter Settings dialog box.

This section describes each filter and its optional settings.

**NOTE:** The following procedures use illustrations from a Windows computer. Any Mac OS differences are noted.

### Configuring the TIFF/IT to PS filter

TIFF/IT (Tagged Image File Format/Image Technology) is a common TIFF standard. The TIFF/IT-p1 file format usually consists of three files. All TIFF/IT-p1 files contain an FP (Final Page) file. The FP file includes page dimension and position required subfiles, such as CT (Contone) and LW (Line Work) files. CT files contain all photographic imagery. LW files contain high resolution data, such as line art images, text, or lines from drawings.

TIFF/IT-p1 files may also include MP (Monochrome Picture), HC (High resolution Contone), BL (Binary Line), or BP (Binary picture) files.

When you drag and drop your TIFF/IT-p1 files, your output is a pre-separated PostScript with one separation per page.

Follow these guidelines to convert your TIFF/IT-p1 job:

Enable the Combine Separations print option. For more information about setting print options, see [Print Options](#).

- Make sure that you have all the necessary files for the TIFF/IT-p1 job. You must place all of the files in the Hot Folder at the same time. If there is a file missing, the job will not process and you will receive an error.

- If the multiple files for the TIFF/IT-p1 job are stored in a folder, you may place the entire folder in the Hot Folder.

- If you download the TIFF/IT-p1 job using the Download command, all files may be inside a folder and the entire folder maybe downloaded.

**NOTE:** The imposition feature is not available if you configure the TIFF/IT to PS filter.
To configure the TIFF/IT to PS filter options

1. Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

   The TIFF/IT Filter Options dialog box appears.

2. Configure the following options:
   
   - **Resolution (Auto, 200, 400, or 600)**: Choose the final resolution of the PS output. Select Auto to use the device resolution of the digital press.
   
   - **Compression (None or RLE Lossless)**: Select if you want compression for your PS output.
   
   - **Anti-Aliasing (Nearest Neighbor Faster or Bilinear Better)**: Select how you want to partially fill the edge pixel by choosing the Anti-Aliasing method for your PS output.

3. Click OK.

Configuring the CT/LW to PS filter

The CT/LW filter accepts multiple CT (Continuous Tone) and LW (Line Work) files and an FP (Final Page) file. It determines the page dimensions of the combined file based on the FP, LW, and CT files, in that order. Spot colors are converted to process CMYK using conversion values specified in the CT/LW files. The combined file is a single RLE compressed CMYK image, and you can specify the resolution.

When you drag and drop your CT, LW, or FP files, your output is a single PS file.

**Note:** Some CT/LW files may include a “.” (period) at the beginning of the file name, indicating that they are hidden files. Make sure you turn on Show Hidden Files in your folder settings. For more information, see the documentation that accompanies your system.

In order to ensure that all files, including hidden files, are copied and processed, drop the entire CT/LW page folder containing all the necessary files.
To configure the CT/LW to PS filter options

1. Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

   The CT/LW Filter Options dialog box appears.

2. Choose the final resolution (Auto, 200, 400, or 600) for your image. Choose Auto to use the device resolution of the digital press.

3. Click OK.

Configuring the DCS 2.0 to PS filter

The DCS 2.0 (Desktop Color Separation) to PS filter accepts DCS 2.0 files and outputs a single preseparated PS file.

This plug-in accepts the following DCS 2.0 files:

- Single/Multiple DCS files, no composite
- Single/Multiple DCS files with grayscale composite
- Single/Multiple DCS files with color composite

The DCS 2.0 filter has no configurable options; however, you must follow these guidelines to convert your DCS 2.0 job:

- Enable the Combine Separations print option. For more information about setting print options, see Print Options.
- Make sure that you have necessary multiple files for a DCS 2.0 job and in one folder. If a file missing, the job fails to process and an error message appears.
- If multiple files for a DCS 2.0 job are stored in a folder, you may place the entire folder in the Hot Folder.
- If you download a DCS 2.0 job using the Download command, all files may be inside a folder. You must download the entire folder.

**Note:** If you configure the DCS 2.0 to PS filter, the Imposition feature is not available.
Configuring ExportPS filter

ExportPS was developed by Creo-Scitex as an option to their Brisque print workflow. ExportPS translates Brisque jobs into portable, raster PS or EPS output that can be processed on the digital press.

The Export PS filter processes the ExportPS file by rendering and resampling it to the resolution of the digital press. You can choose the output to be PS or PDF.

**To configure the ExportPS filter options**

1. Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

   The ExportPS Filter Options dialog box appears.

2. Configure the following options:

   **Output (PS or PDF):** Select the final output.

   **Resolution (Auto, 200, 400, or 600):** Choose the final resolution of the output. Choose Auto to use the device resolution of the digital press.

3. Click OK.

Configuring the PDF2Go filter

PDF2Go is a PDF output developed by Creo-Scitex as an option to their Brisque workflow. It usually contains PDF layers of rasterized CT and LW job pages, each with a different resolution, in one PDF file.

The PDF2Go filter processes the PDF2Go file by rendering and re-sampling it to the resolution of the digital press. You can choose PS or PDF output.

**To configure the PDF2Go filter options**

1. Follow the steps in “Specifying filter settings for a Hot Folder” on page 70.

   The PDF2Go Filter Options dialog box appears.
2 Configure the following options:

**Output (PS or PDF):** Select the final output.

**Resolution (Auto, 200, 400 or 600):** Choose the final resolution of the output. Choose Auto to use the device resolution of the digital press.

3 Click OK.

### Configuring the EPS to PS filter

The EPS to PS filter accepts all EPS files. This filter gives you the flexibility to force changes in the final dimensions and page size of a file.

#### TO CONFIGURE THE EPS TO PS FILTER OPTIONS

1 Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

The EPS to PS Filter Options dialog box appears.

2 Configure the following options:

**Scale Image Width and Height to:** Select to scale all EPS files to the desired size. Choose inches or millimeters from the pull-down menu.

**PS Page Size:** Select to print all EPS files to the page size that you specify. Choose a page size from the menu or choose a Custom Page size. With Force Page Size selected, you can:

- Ignore unprintable margins to print the EPS on the entire page size.
- Shrink oversized images to fit larger images proportionately.
- Expand small images to fit small images proportionately.
- Automatically rotate images according to the selected page orientation.
- Set the position of the image.

3 Click OK.
Configuring the PDF/X Preflight filter

PDF/X (PDF Exchange) Preflight is a subset of Adobe PDF designed specifically for prepress data interchange. It defines how applications that read and create PDF/X files should behave.

Two PDF/X standards are commonly used:

- **PDF/X-1a standard**: This addresses blind exchanges to verify that files contain only CMYK (and/or spot colors), with no RGB or device independent (color-managed) data.
- **PDF/X3**: This standard meets all the requirements of a PDF/X-1a, but contains device independent (color-managed) data.

The PDF/X Preflight filter allows you to verify that a PDF document is PDF/X-compliant with either the PDF/X-1a or PDF/X3 standard. If the PDF file is not PDF/X-compliant, the job fails to process and an error report appears.

**To configure PDF/X Preflight filter options**

1. Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

   The PDF/X Preflight Options dialog box appears.

2. Configure the following options:

   - **Specifications (PDF/X-1a or PDF/X3)**: Select to verify PDF/X-1a or PDF/X3 compliance.
   - **Save Error Report**: Select to generate an error report for failed jobs.
   - **Error Report Path**: Browse to select an error report location.

3. Click OK.

Configuring the TIFF to PDF filter

The TIFF to PDF filter accepts TIFF files up to TIFF 6.0. In addition to allowing you to convert TIFF files automatically without opening them from the application from which they were created, the TIFF to PDF filter allows you to change the final page size of print jobs and adjust the resolution.

This filter is Non-exclusive, so you can download basic file formats. For more information about Non-exclusive filters, see “About file conversion” on page 67.
To configure TIFF to PDF filter options

1. Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

The TIFF to PDF Filter Options dialog box appears.

2. Configure the following options:

   **Scale Image Size To**: Select this option to scale all TIFF files to the desired size and resolution. Choose inches or millimeters from the Width and Height menus.

   **PDF Page Size**: Select this option to print all the TIFF files to the page size that you specify. Select a page size from the menu or choose a Custom Page size. With Force Page Size selected, you can:
   - Shrink oversized images to fit larger TIFF images proportionately.
   - Expand small images to fit small TIFF images proportionately.
   - Automatically rotate TIFF images according to the selected page orientation.
   - Select the position of the TIFF image.

3. Click OK.
Configuring the JPEG to PDF filter

The JPEG to PDF filter accepts all standard JPEG files. In addition to allowing you to convert JPEG files automatically without opening them from the application from which they were created, the JPEG to PDF filter allows you to change the final page size of print jobs and adjust the resolution.

This filter is Non-exclusive, so you can download basic file formats. For more information about Non-exclusive filters, see “About file conversion” on page 67.

To configure JPEG to PDF filter options

1. Follow steps 1-4 in “Specifying filter settings for a Hot Folder” on page 70.

   The JPEG to PDF Filter Options dialog box appears.

2. Configure the following options:
   - **Scale Image Size to**: Select this option to scale all JPEG files to the desired size and resolution. You can choose from inches or millimeters from the pulldown menus.
   - **PDF Page Size**: Select this option to print all JPEG files to the page size that you specify. Choose a page size from the menu or choose a Custom Page size. With Force Page Size selected, you can:
     - Shrink oversized images to fit larger JPEG images proportionately.
     - Expand small images to fit small JPEG images proportionately.
     - Automatically rotate JPEG images according to the selected page orientation.
     - Select the position of the image.

3. Click OK.
When proofing, most customers prefer to print in Contone mode, which delivers the best color with minimal efforts and settings. For advanced proofing purposes, Fiery Graphic Arts Package offers user-controlled halftone generation. Halftoned proofs simulate, with reasonable accuracy, the final dots imaged on films or plates for offset printing. The halftone screening feature allows you to define the custom screening functions applied to your print job.

For example, select Contone if you do not use halftone screening for your print job. Select Newsprint for a look and feel similar to a newspaper for your print job.

**Halftone screening workflow**

You can select pre-set halftone screens to print jobs with good results. When you must customize the values for a halftone screen, you must define a custom halftone in your application or at Fiery Server Setup, and then select the screen in the Halftone Screen print option from the printer driver.

For information about the Halftone Screen print option and the procedure to print with a pre-set halftone screen, see the following section. For information about the Halftone Screen Definitions pane and the procedure to specify custom halftone screen values, see page 81.

**Halftone Screen print option**

Access the halftone screening feature through the Halftone Screen print option. Choose from the following commands:

- **Printer’s default**: Uses a pre-defined Halftone Screen built into the Fiery EXP6000/EXP5000.

- **Application Defined**: Allows processing of PS halftone functions contained in the PS job. For information about the supported applications, see page 87.

- **Contone**: Allows processing of a job without the halftone screening feature.

- **Newsprint**: Provides a look and feel similar to a newspaper.

- **User Defined Screen1/2/3**: Applies a user-defined screen based on the settings in Fiery Server Setup.

**Note**: Use Newsprint and User Defined Screen1/2/3 with all applications, including Microsoft Office.
Printing a job with a pre-set halftone screen

Use the following procedure to print a job with a pre-set halftone screen from the printer driver.

TO PRINT A JOB WITH A HALFTONE SCREEN

1 Choose Print from your application.

2 Select Fiery EXP6000/EXP5000 as your printer and click Properties.

   The Properties dialog box appears with the Fiery Printing tab selected.

3 Click the Image Quality option bar.

4 Choose a pre-set halftone screen from the Halftone Screen menu.

   For information about the selection, see page 80.

5 Click OK to close the Properties dialog box.

6 Click Print.

   The job with the pre-set halftone screen is printed to the Fiery EXP6000/EXP5000.

Halftone Screen Definitions pane

You can define three custom halftone screens in the Halftone Screen Definitions pane of the Fiery Server Setup. For each of these screens, you can define the following values:

Angle

Type a number (from 0-360) for each color of Cyan, Magenta, Yellow, and Black.

Frequency

If Fiery Graphic Arts Package is enabled, type a value for the screen frequency for all color channels.
LPI (screen frequency)
If Fiery Graphic Arts Package, Premium Edition is enabled, type a separate frequency value for each color channel.

You can enter a separate frequency value for each color channel. By selecting the check box next to the link icon, the values for LPI (lines per inch; that is, the numbers of rows of spots that combine to form a halftone dot) for the channels are the same for all four channels.

Dot Shape
Allows you to select a PostScript function for dot shape. When you select the Custom option, the Dot Shape dialog box appears. This dialog box provides a text field in which you enter a PostScript function. When this dialog box is first opened, it reflects the last custom-defined dot shape.

Setting Halftone Screen Definitions
Define up to three server-resident custom halftone screens to select from the printer driver. Use the following procedure to access the Halftone Screen Definitions pane and specify the values.

To specify custom halftone screens
1 Right-click FieryBar on the monitor and choose Setup Fiery.

You can also access the Fiery EXP6000/EXP5000 Server Setup by right-clicking the Fiery icon on the Windows XP taskbar and choosing Setup Fiery.

NOTE: To access the Fiery Server Setup, you must log on with an Administrator password for Windows XP. For more information, see Configuration and Setup.

The Fiery Server Setup dialog box appears.
2 Click the Printer Setup tab and select Halftone Screen Definition.

The Halftone Screen Definitions pane appears.

3 Specify the values for the available options.

If Fiery Graphic Arts Package, Premium Edition is enabled at your site, specify a screen frequency for each color channel. For more information about the available options, see page 81.

4 Click OK.

Select these user-defined halftone screens from the printer driver.
Calibrating for custom halftone screens

When color quality is important, make sure that the Fiery EXP6000/EXP5000 is calibrated for the particular halftone screen you use. Changing a halftone screen usually modifies the color response of the digital press.

The best color is achieved when an Output profile that is associated with the appropriate calibration response is selected at print time. However, when custom halftones are specified, the Fiery EXP6000/EXP5000 does not have adequate information about the resulting color response. For this reason, good color with custom halftone is often possible only after custom halftone calibration and if using a profile based on this custom halftone.

Use the following procedure to calibrate the Fiery EXP6000/EXP5000 for custom halftone screens.

**To calibrate the Fiery EXP6000/EXP5000 for custom halftone screens**

1. Prepare the measurement instrument you use for calibration.
   
   For information about supported measurement instruments, see *Color Printing*.

2. In the User Software CD, open the folder that contains the custom halftone calibration files.
   
   The folder locations for Macintosh and Windows are as follows:
   
   **Mac OS**: Mac Color Files: Calibration Files: Halftone Calibration Files: Photoshop or Other Applications
   
   **Windows**: Windows Color Files\Calibration Files\Halftone Calibration Files\Photoshop or Other Applications
   
   The folder contains images of the measurement pages for various instruments and page sizes. If you print halftone screens only from Adobe Photoshop, open the Photoshop folder; otherwise, open the Other Applications folder.

   **Note**: When opening or printing these files, never “color-manage” using PostScript Color Management or ICC profile, which include color conversions.

3. From Photoshop, locate the image file corresponding to your instrument and page size and open the file.
   
   From other applications, open a blank document and place the EPS file that matches your instrument and page size.
   
   The images were prepared for the final sheet page size. If you are placing an image, do so without using margins. Ignore warnings that the image may be clipped.

   **Note**: If these measurement pages can also be used with the Fiery EXP6000/EXP5000 standard screens, make sure to properly set the PPD print option (Digital Press mode) that controls the screen.

4. Print the measurement page using your custom halftone and other print option settings.
   
   This page is now the custom calibration measurement page.
You must print this measurement page with the CMYK Simulation Profile print option set to ColorWise Off, which produces an uncalibrated page.

**NOTE:** To calibrate your digital press, you must print CMYK patches in the raw state of the printer. Except for the Output Profile print option, the ColorWise print options are irrelevant and are ignored.

**NOTE:** To increase the speed and reliability of the calibration, print your measurement page with the appropriate print option settings to a PS file. The next time you calibrate, download this PS file. Retaining this file in the Hold queue of the Fiery EXP6000/EXP5000 speeds up the calibration process.

5 **Start ColorWise Pro Tools Color Editor and open any Output profile.**

**NOTE:** You can select any Output profile because you will be printing the measurement page with CMYK Simulation Profile set to ColorWise Off. With this setting, color conversions using Output profile will not occur.

For information about Color Editor, see ColorWise Pro Tools Help.

6 **Save this Output profile under a new name descriptive of your custom halftone screen.**

7 **Use ColorWise Pro Tools Profile Manager to associate this Output profile with an appropriate Calibration Set.**

Even though the CMYK Simulation Profile print option is set to ColorWise Off, it is important to associate the appropriate Calibration Set to the Output profile because its measurement is used for calibration.

For information about Profile Manager, see ColorWise Pro Tools Help.

8 **Use ColorWise Pro Tools Calibrator to perform calibration.**

**NOTE:** Do not use the Print button to generate the measurement page in Calibrator. Instead, use the measurement page that you printed in step 4.

For information about Calibrator, see *Color Printing*.

### Profiling for custom halftone screens

For optimal color, it may be necessary for you to create a custom profile. Although you must calibrate often (generally once a day), you can create the following custom profiles once.

**To profile custom halftone screen for the Fiery EXP6000/EXP5000**

1 **Calibrate the printer using the previous procedure.**

2 **Use EFI Color Profiler to print the calibration measurement page with the same halftone screen setting that you used to calibrate.**

**NOTE:** Use the same Output profile as the one that was saved in calibration, and print the Profiler patches with the CMYK Simulation Profile print option set to None.
3 **Use ColorWise Pro Tools Profile Manager** to set the profile that was saved during calibration as the System default profile.

This is necessary because downloaded profiles take their calibration targets from the System default profile.

4 **Download the profile to the Output area.**

Make this profile the new default. Verify that it is associated with the Calibration Set that applies to your custom halftone.

**Printing with a custom halftone screen**

After you define the custom halftone screens, you can select a user-defined halftone screen from the printer driver. Use the following procedure to print a job with a custom halftone screen.

---

**TO PRINT A JOB WITH A CUSTOM HALFTONE SCREEN**

1 **Choose Print** from your application.

2 **Select Fiery EXP6000/EXP5000 as your printer and click Properties.**

   The Properties dialog box appears with the Fiery Printing tab selected.

3 **Click the Image Quality option bar.**

4 **Choose a custom halftone screen from the Halftone Screen menu.**

   **NOTE:** Choose one of the custom halftone screens that you defined in the Halftone Screen Definitions pane.

5 **Click OK to close the Properties dialog box.**

6 **Click Print.**

   The job with the custom halftone screen is printed to the Fiery EXP6000/EXP5000.
Supported applications

The following applications have been tested with Mac OS and Windows for compatibility with the Application Defined setting in the Halftone Screen print option. Other applications should work, as well, as long as they use standard PS conversions on halftone screen definitions and the parameters used in the definitions are within the physical limitations of the digital press.

• Adobe Acrobat 6
• Adobe Illustrator 8, 9, and 10
• Adobe InDesign 1.5, 2, and CS
• Adobe PageMaker 6.5 and 7
• Macromedia FreeHand 9, 10, and MX
• QuarkXPress 4.1, 5, and 6
The Postflight feature helps you determine why some printed jobs may not deliver expected color. Acting as a diagnostic and training tool for all users, it provides helpful global and object-specific information about how a job is actually received and processed by Fiery EXP6000/EXP5000.

Use Postflight to troubleshoot color problems with a previously printed job or as a preventive measure. You can print the original document (or RIPped and previewed) with all objects (images, graphics, and text) color-coded. The Postflight report explains what color spaces are used in the job and what print options affect those spaces. The report also provides information about the printing environment, such as calibration date, time, and method. Print a Test Page to verify the condition of the printing environment.

Postflight is a powerful analysis tool. Postflight reports enumerate not only those color spaces that are used by visible objects, but any color space called by a job. This can be useful in diagnosing puzzling situations that may require correction. For example: using one specific combination of a printer driver, an OS, and a desktop publishing application emitting separations for plates, you might find that: 1) the Postflight color-coded pages show the Cyan, Magenta, and Yellow separations in the “DeviceGray” color space, while the Black separation is shown in the “DeviceCMYK” color space; 2) the Postflight report enumerates: DeviceGray, DeviceCMYK and DeviceRGB. What used to require a PostScript expert to decipher, can now be interpreted in minutes using Postflight reports: the Cyan, Magenta, and Yellow pages are defined in “DeviceGray”, the Black page is using the “K” channel of DeviceCMYK, and the job is calling for the RGB color space, without applying it on any user-visible object.
About Postflight

When the Postflight print option is set to values other than Off, it provides the following information to help you identify possible problems: Postflight Test Page, Postflight color-coded pages, and Postflight reports.

Postflight Test Page

You can print the Postflight Test Page alone or in combination with the color-coded pages. The Test Page is printed using the exact same media and global settings (such as calibration) as your job. However, color objects on this page are printed independently of the user-specified source color definitions (such as CMYK simulation and RGB).

If the color on this page is not accurate, the problem lies with the printing environment (such as the calibration, output profile, or print device).

If the color on this page prints correctly, but objects in your job do not print in expected colors, it is likely that the problem lies with the color setting specific to these objects. Problems with objects can include wrong color values for text and graphics, bad quality images, or out-of-gamut colors.

Postflight color-coded pages

With this option, Postflight prepares a color-coded version of the original document that displays each object with a color corresponding to the color space that the Fiery EXP6000/EXP5000 received for the object.

The colors used to represent the color spaces for objects are as follows:

- Gray objects: Gray
- CMYK objects: Cyan
- RGB objects: Red
- Device-Independent objects: Indigo
- Spot color objects: Yellow

By reviewing the colors for all objects, you can identify the print option settings that affect the color conversion of the objects and make appropriate modifications.
Postflight reports

You can print two types of reports on color-coded pages, either alone or combined with the color-coded document. These reports are printed on the Fiery EXP6000/EXP5000 default paper size (Letter for US, A4 for metric) and use the default calibrated color mode.

Choose from the following two types of Postflight reports:

- **Verbose Report** includes detailed static information with advice on possible procedures and values. An icon identifies the "detailed" information areas of the report.

- **Concise Report** includes only job-specific information. This option is good for advanced users who do not want the instructions which may seem redundant to them.

**Verbose and Concise Reports**

The reports provide a document header with information (such as job name, date and time printed, and user name), ColorWise global settings page, and object-specific settings pages. All pages include the job name, postflight date/time, and pagination in the bottom margin.

- **ColorWise global settings page** provides information that affects every object in a job, such as Calibration Set, when the Fiery EXP6000/EXP5000 was calibrated, and the method used for calibration.

- **Object-specific settings pages** provides a list of settings that were used to process every object in each color space, thus suggesting the locations to correct the problem. For example, if you see a problem with an object that is displayed in Cyan in a color-coded page, you can review the settings listed in the CMYK Objects page, and try changing those settings.

- **Spot colors** lists all spot colors.

  For spot colors, the Postflight report lists the colors that are used in a job. It also displays whether these colors are defined in the Fiery EXP6000/EXP5000. When a spot color is defined in the Fiery EXP6000/EXP5000, a patch is printed next to the color name. When a color is not defined in the Fiery EXP6000/EXP5000, a white patch with an X is printed.

**Important notes on Postflight reports**

The main purpose of Postflight is to help you detect, diagnose, and prevent color-related problems. In contrast to generic preflight software, which attempts to predict how a job would be processed, a postflighted job is fully processed by the Fiery EXP6000/EXP5000, allowing accurate reporting on the settings how the job was handled.

This Postflight feature is especially useful in cases where a workflow that was used to submit a job inadvertently converts colors. This conversion happens with some printer drivers, printing options, and conversions to PDF.

This report focuses on color processing and therefore does not list every printing option that affects your job. For more information about the ColorWise print options, see *Color Printing*. 
Postflight reports list only those color spaces that were submitted to the Fiery EXP6000/EXP5000 with your job. You may occasionally find that a job produces a Postflight report that includes information about color spaces you cannot locate in the job’s color-coded pages. This happens when an object in this color space is used in the job but is masked by another object, when an object is very light (for example, 0% of a spot color), or when the specific application or printer driver asks the Fiery EXP6000/EXP5000 to process a particular color space but does not use it for user-visible objects.

Postflight print option

Access the Postflight feature through the Postflight print option. You can select a single component or all components for the Postflight information.

The following values are available for the Postflight print option:

- Off (Default)
- Verbose Report Only
- Concise Report Only
- Test Page Only
- Color-Coded Pages Only
- All Components (Color-coded document pages, test page, and verbose report)

**Note:** Select a portion of a job to print the Postflight pages by selecting the appropriate page range of a job from the printer driver.
Postflight workflow

In most cases, the default settings in the ColorWise print options are adequate, and you do not need to change them. However, there are times when you see unexpected colors in a job. Postflight is a procedure performed after you print a document and see unexpected or inadequate colors. If you have access to Command WorkStation, Postflight helps you catch color problems before you actually print. Postflight processes your job and collects information about the color objects throughout. The information is then displayed in three forms: color-coded document pages, a Test Page, and a Postflight report.

**NOTE:** The background defined in the Paper Simulation is not indicated as a CMYK object in the Postflight reports. For more information about Paper Simulation, see Paper Simulation White Point Editing.

**NOTE:** You cannot use the Postflight feature with the following features at the same time: Progressives, Substitute Colors, and Combine Separations. Constraints are set for these print options from the printer driver.

The following scenarios show how Postflight can be helpful to users who demand high-quality color.

**To diagnose an unexpected color (see page 93)**
Use Postflight to diagnose unexpected color in a job, or determine which printing or calibration settings apply to a job.

**To check the calibration status prior to printing a job (see page 95)**
Consider the following before printing a job:

- The Fiery EXP6000/EXP5000 may include many Calibration Sets. Which Calibration Set applies to my job?
- When was the Fiery EXP6000/EXP5000 last calibrated?
- Which instrument was used for the last calibration?

**To check the quality of the output profile (see page 96)**
If you are considering using a new paper for which you do not have a custom profile, or if you suspect that the output profile for your print device may not precisely describe its color behavior, check your output profile by printing the Postflight Test Page.
To diagnose a color problem of a specific object (see page 97)
When experts have verified that the calibration is correct and that the global settings, including the output profile, are correct, but the color of a specific object is still not as intended, you can print a color-coded document and diagnose the problem.

The detailed procedures of these scenarios are described in the following sections.

**NOTE:** For each of the following procedures, instead of printing the report to the Fiery EXP6000/EXP5000, you can also send it to the Hold queue of the Fiery EXP6000/EXP5000 and preview the information (of a job with raster data) in ImageViewer. For more information about ImageViewer, see “EFI ImageViewer” on page 57. To view the color of a job, you must set your monitor and monitor profile correctly. For more information about the monitor and monitor profile, see page 15.

**NOTE:** The procedures for printing a job from a Windows and a Mac OS computer are similar.

**Scenario 1: Diagnose an unexpected color**
Use the following procedure to print a job with Postflight set to Off.

**To print a job**

1. Open a job from your application.
2. Choose Print.
3. Select Fiery EXP6000/EXP5000 as your printer and click Properties.
   The Properties dialog box appears with the Fiery Printing tab selected.
4. Click each option bar, and specify the values for the print options.
5 Click the Reporting print option bar.

Make sure that Postflight is set to Off.

6 Click OK to close the Properties dialog box.

7 Click Print.

The job is printed to the Fiery EXP6000/EXP5000.

After you print a job, use the following procedure to diagnose an unexpected color and print the job with edited color settings.

---

TO DIAGNOSE AN UNEXPECTED COLOR AND PRINT WITH EDITED COLOR SETTINGS

1 Click the Reporting print option bar.

2 Choose All Components from the Postflight menu.

   For information about the components of Postflight, see page 89.

3 Click OK to close the Properties dialog box.

4 Click Print.

   Postflight Test Page, color-coded document pages, and Postflight Reports are printed.

5 Review all Postflight pages.

   For information about the Postflight pages, see page 89.

6 Make appropriate changes based on all Postflight pages.

   For more information about the changes, see the following section.

7 Choose Off from the Postflight menu.

8 Click OK.

9 Click Print.

   The job with the edited color settings is printed to the Fiery EXP6000/EXP5000.

10 Return to Step 1, if needed.

   Repeat the steps until you get satisfactory color results.
Making changes

After reviewing the Postflight information, determine what changes are necessary and apply the changes. Depending on your printing environment, the condition of the print device, and the color settings, possible changes are as follows:

• Correct problems with the print device (see the documentation that accompanies your print device).
• Calibrate the Fiery EXP6000/EXP5000 (see Color Printing).
• Edit the colors of the output profile with Color Editor (see Color Printing).
• Change the default settings in the Color Process Flow tab in Color Setup (see Color Printing).
• Change the job specific print option settings using Command WorkStation overrides.

Scenario 2: Check the calibration status

Use the following procedure to check the calibration status prior to printing a job.

To check the calibration status and print with the optimum calibration condition

1. Click the Reporting print option bar.

2. If you have not printed the Verbose Report, choose Verbose Report Only from the Postflight menu.
   If you have printed the Verbose Report and are familiar with the content, choose Concise Report Only.
   For information about Postflight reports, see page 90.

3. Click OK.

4. Click Print.
   The Verbose Report or Concise Report is printed.

5. Review the information in the ColorWise global settings page.
6 Perform calibration, if needed.

If service has been performed on the print device since the last calibration, or calibration has not been performed, perform calibration using the Calibration Set specified in the Postflight report.

For more information about Calibration Set, see the Color Printing.

7 Choose Off from the Postflight menu.

8 Click OK.

9 Click Print.

10 The job is printed to the newly calibrated Fiery EXP6000/EXP5000.

Scenario 3: Check the quality of output profile

Use the following procedure to check the quality of the output profile of the print device.

**To check the quality of output profile and print with the optimum output profile**

1 Click the Reporting print option bar.

![Image of Reporting print option bar]

2 Choose Test Page Only from the Postflight menu.

For information about Postflight Test Page, see page 89.

3 Click OK.

4 Click Print.

Postflight Test Page is printed to the Fiery EXP6000/EXP5000.

5 Review the quality of the color on the Postflight Test Page.

**NOTE:** Make sure this page was printed with the same media and print option settings as the job.

6 Review the instructions on the Postflight Test Page.
7 Edit the color of the output profile, or create a profile, if needed.

It may be necessary to customize the output profile or create one to get optimal results on the media the job is using.

8 Choose Off from the Postflight menu.

9 Click OK.

10 Click Print.

The job is printed to the Fiery EXP6000/EXP5000 with the edited or newly created output profile.

**Scenario 4: Diagnose a color problem of a specific object**

Use the following procedure to diagnose a color problem.

TO DIAGNOSE A COLOR PROBLEM OF A SPECIFIC OBJECT AND PRINT WITH THE EDITED COLOR SETTINGS

1 Click the Reporting print option bar.

2 Choose Color-Coded Page Only from the Postflight menu.

For information about Postflight color-coded pages, see page 89.

3 Click OK.

4 Click Print.

Postflight color-coded pages are printed to the Fiery EXP6000/EXP5000.

**NOTE:** Alternatively, you can send the Postflight color-coded pages to the Hold queue of the Fiery EXP6000/EXP5000 and preview them using ImageViewer. To preview the pages using ImageViewer, make sure that your monitor is set up according to the manufacturer's recommendations and that the correct monitor profile is specified for your monitor. For information about monitor profile, see page 15.
5 Review the Postflight color-coded document pages.

6 Make changes to the color settings, as needed.

For information about the ColorWise print options for various color spaces, see Color Printing.

**NOTE:** Use the Color-Coded Pages Only setting to send a job to another print device that has a specific color-space requirement. For example, a document targeted to a CMYK-only press must have only Cyan-colored objects.

7 Choose Off from the Postflight menu.

8 Click OK.

9 Click Print.

The job is printed to the Fiery EXP6000/EXP5000 with the edited color settings.
MULTIPLE PLATE SEPARATIONS

Multiple plate separations feature allows you to combine the multiple pre-separated color plates of a PostScript job into a composite color print. It supports: Cyan, Magenta, Yellow, Black, and one or more spot colors.

The results of combining the multiple plates are predictable and accurate, regardless of the original application use. This feature also fully supports DCS 2.0 file formats when included in a PS print job from a page layout application.

**Multiple plate separations workflow**

Use the following procedure to print a composite color print from the printer driver.

**NOTE:** The procedures for printing a composite color print from a Windows and a Mac OS computer are similar.

**TO PRINT A COMPOSITE COLOR PRINT**

1. Open a document that has been color separated in a supported application.
2. Choose Print.
3. Select Fiery EXP6000/EXP5000 as your printer and click Properties.
   The Properties dialog box appears with the Fiery Printing tab selected.
4. Click the ColorWise print option bar.

5. Choose On in the Combine Separations area.
6. Click Print.

A composite color print is printed to the Fiery EXP6000/EXP5000.
**Combine Separations print option**

Access the Multiple Plates Separations feature through the Combine Separations print option from the printer driver.

The following values are available for the Combine Separations print option:

- Off (Default)
- On

**Supported applications**

The following applications have been tested with Mac OS and Windows for compatibility with the Multiple Plates Separations feature:

- Adobe Acrobat 6
- Adobe Illustrator 8, 9, 10, and CS
- Adobe InDesign 1.5, 2, and CS
- Adobe PageMaker 6.5 and 7
- Macromedia FreeHand 9, 10, and MX
- QuarkXPress 4.1, 5, and 6
The HKS, DIC, and Toyo inks are supported with Fiery Graphic Arts Package and Fiery Graphic Arts Package, Premium Edition. With this feature, the Fiery EXP6000/EXP5000 offers accurate simulations of HKS, DIC, and Toyo spot colors, in addition to PANTONE spot colors, when you set the Spot Color Matching print option to On.

For more information about updating the status of Fiery Graphic Arts Package, see page 12.

Workflow with HKS, DIC, and Toyo ink support

Use the following procedure to print a document that contains HKS, DIC, or Toyo spot colors.

**NOTE:** The procedures for printing a job with the HKS, DIC, or Toyo spot colors from a Windows and a Mac OS computer are similar.

**TO PRINT A DOCUMENT WITH HKS, DIC, OR TOYO SPOT COLORS**

1. Open a document that contains HKS, DIC, or Toyo spot colors in your application.
2. Choose Print from your application.
3. Select Fiery EXP6000/EXP5000 as your printer and click Properties.
   - The Properties dialog box appears with the Fiery Printing tab selected.
4. Click the ColorWise print option bar.
5. Click Expert Settings.
   - The Expert Color Settings dialog box appears.
6. Select the Spot Color Matching print option and click OK.
7. Click Print.
   - The job is printed to the Fiery EXP6000/EXP5000 with an accurate simulation of HKS, DIC, or Toyo spot colors.
**Spot Color Matching print option**

Access the HKS, DIC, and Toyo ink support feature through the Spot Color Matching print option.

The following values are available:

- Printer's Default (On)
- Off
- On
The Paper Simulation feature gives you the benefit of the absolute colorimetric rendering that renders the white point of the source color space as a visible color in the output profile color space.

**Paper Simulation workflow**

Use the following procedure to print a job with the fixed Paper Simulation feature On.

**NOTE:** The procedures for setting the Paper Simulation print option from Windows and Mac OS computers are similar.

**TO PRINT A JOB WITH THE FIXED PAPER SIMULATION FEATURE ON**

1. Choose Print from an application.

2. Select Fiery EXP6000/EXP5000 as your printer and click Properties.

   The Properties dialog box appears with the Fiery Printing tab selected.

3. Click the ColorWise print option bar and then click Expert Settings.

   The Expert Color Settings dialog box appears.

   ![Expert Color Settings](image)

4. Select the Paper Simulation print option and click OK.

5. Click Print.

   The job is printed to the Fiery EXP6000/EXP5000 with the Paper Simulation feature.
Paper Simulation print option

Turn the Paper Simulation feature on or off through the print option from the printer driver.

- **On**: Performs Absolute Colorimetric rendering.
- **Off** (Default): Performs Relative Colorimetric rendering.
Index

A
Auto Trapping
about 46
Apply Auto Trapping option 47
Color Setup 36
configurable 46
default 46
defining 49
factory defaults 49
Image Quality print option bar 46
pane 47
print option 46
printing 49
tab 47, 49
trap color reduction 48
trap object types 49
trap shape 48
trap width 48
workflow 46
definitions 41
deleting 45
Distance from the edge 44
duplicating 44
editing 44
factory defaults 45
Job Information 43
pane 40
Print Control Bar option 41
print option 38
printing 45
Reporting print option 39
System Page Size 42
pane 40
Text Location 44
workflow 38
CT/LW to PS Filter
about 73
configuring 73

B
Brightness, Paper Simulation 18

C
Color Setup
Auto Trapping 36, 49
Color Process Flow 36
Control Bar 36
Progressives 36
starting 37
colors, proofing 54
Combine Separation
print option 100
Control Bar
about 38
Color Setup 36
Control Bar Definition dialog box 41
Control Bar EPS File 43
creating 41
default control bar 38, 39
defining 41

D
DCS 2.0 to PS Filter
about 74
configuring 74

E
EFI ImageViewer
accessing 57
Navigator window 62
Plate window 65
rotating images 66
setting preferences 60
thumbnail preview 62
zooming in or out 63
EPS to PS Filter
about 76
configuring 76
Exclusive filters 67
Expert Color Settings 103
ExportPS Filter
about 75
configuring 75
<table>
<thead>
<tr>
<th>F</th>
<th>Fiery Graphic Arts Package, Premium Edition features 11 file conversion about 67 File Filter settings selecting 70 File Filters about 68 configuring 72 specifying 70</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Halftone Screen angle 81 Application Defined 80 calibrating 84 Contone 80 Dot Shape 82 frequency 81 Halftone Screen Definitions pane 83 Image Quality option bar 81, 86 LPI (screen frequency) 82 Mac Color Files folder 84 Newsprint 80 print option 80 Printer Setup tab 83 printing 81, 86 User Screen 80 Windows Color Files folder 84 workflow 80 Halftone Screen Definitions pane 81 HKS, DIC, and Toyo inks spot colors 101 workflow 101 Hot Folders about 67 File Filters 67 Hue, Paper Simulation 18</td>
</tr>
<tr>
<td>J</td>
<td>jobs, viewing soft proof of 54 JPEG to PDF Filter about 79 configuring 79</td>
</tr>
<tr>
<td>M</td>
<td>monitor compensation Paper Simulation 21 monitor profile, specifying 15 monitor, setting up 15 Multiple plate separations workflow 99</td>
</tr>
<tr>
<td>N</td>
<td>Navigator window 62 Non-exclusive filters 67</td>
</tr>
<tr>
<td>O</td>
<td>output profile Control Bar 43 Paper Simulation 19, 20, 24, 103 Postflight 89, 92, 95, 96, 97 Spot-On 26, 28</td>
</tr>
<tr>
<td>P</td>
<td>Paper Simulation Brightness 18 fixed values 17, 103 Full (Output GCR) 20, 24 Hue 18 monitor compensation 21 output profile 20 preview 19 print option 17, 103, 104 printing 23, 103 Saturation 18 Save 22 simulation profile 20, 24 white point editing 18 workflow 16, 103 Paper Simulation White Point dialog box 18 editing 19 PDF/X Preflight Filter about 77 configuring 77 PDF2GO Filter about 75 configuring 75</td>
</tr>
</tbody>
</table>
Postflight
   about 89
   accurate reporting 90
   calibration status 92, 95
   color problems 93, 97
   color-coded pages 89, 97
   ColorWise global settings page 90
   ColorWise print options 90
   Concise Report 90, 95
   Detailed Report 90, 95
diagnosing 94
   EFI ImageViewer 97
   global settings page 95
   Hold queue 97
   information 95
   making changes 95
   monitor profile 97
   Object-specific settings pages 90
   Paper Simulation 92
   print option 91
   quality of output profile 92, 96
   Reporting print option bar 94, 95, 96, 97
   reports 90
   Spot colors 90
   Test Page 89, 96
   unexpected colors 92, 93
   vs. Combine Separations 92
   vs. Progressives 92
   vs. Substitute Colors 92
   workflow 92
   Preview, Paper Simulation 19
   previewing thumbnails
   in EFI ImageViewer 62
   Progressives
   about 50
   color channels 53
   Color Setup 36
default 51
   factory defaults 53
   pane 52, 53
   print option 51
   printing 53
   Reporting print option bar 51
   sheets and colors 52
   tab 52
   workflow 50
   proofing colors 54
   R
   rotating images in EFI ImageViewer 66
   S
   Saturation
   Paper Simulation 18
   setting EFI ImageViewer preferences 60
   Soft Proofing 54
   Spot Color Matching
   print option 101
   Spot Color Matching print option 102
   Spot-On
   output profile 26, 28
   RGB or CMYK values 25
   substitute colors 25
   Substitute Colors
   accuracy 33
   adding substitute colors 27, 31
   CMYK (0-100%) mode 32
   color substitution 34
defining 27
   Set Center Patch Color 28
   Spot-On Color Search 30
   Spot-On main window 28
downloading substitute groups 35
   new 25
   new substitute group 27
   principles 33
   printing 30
   priority scheme 34
   RGB (0-100%) mode 32
   RGB (Device Code 0-255) mode 32
tolerance 32
tolerance range 33
   uploading substitute groups 35
   vs. Postflight 25
   workflow 25
   T
terminology 9
   TIFF to PDF Filter
   about 77
counting 77
   TIFF/IT to PS Filter
   about 72
   configuring 72
   Two-Way Communication 13
   V
   viewing plate data in EFI ImageViewer 65